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Legal notes
© 2017 ISD ® Software und Systeme GmbH. All rights reserved.

This User Guide and the software described herein are provided in conjunction with a license and may only be used or copied in
accordance with the terms of the license. The contents of this User Guide solely serve the purpose of information; it may be
modified without prior notice and may not be regarded as binding for the ISD Software und Systeme GmbH. The ISD Software und
Systeme GmbH does not assume any responsibility for the correctness or accuracy of the information provided in this document. No
part of this document may be reproduced, saved to databases or transferred in any other form without prior written permission by
the ISD Software und Systeme GmbH, unless expressly allowed by virtue of the license agreement.

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers.

The license management portion of this Licensee Application is based upon one or more of the following copyrights:

Sentinel®RMS
© 1989-2017 SafeNet, Inc.
All rights reserved.

Sentinel @EMS™
© 2008-2017 SafeNet, Inc.
All rights reserved.

Sentinel® is a registered trademark of SafeNet, Inc.

This work contains the following software owned by Siemens Industry Software Limited:
D-CubedTM 2D DCM © 2017. Siemens Industry Software Limited. All Rights Reserved.
D-CubedTM 3D DCM © 2017. Siemens Industry Software Limited. All Rights Reserved
D-CubedTM AEM © 2017. Siemens Industry Software Limited. All Rights Reserved.

PDF3D®
© 2003-2017 Visual Technology Services Ltd. All rights reserved. Is a registered trademark of Visual Technology Services Ltd.

Copyright 2008, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions
are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Code generated by the Protocol Buffer compiler is owned by the owner of the input file used when generating it. This code is not
standalone and requires a support library to be linked with it. This support library is itself covered by the above license.

Lp_solve
HIiCAD uses the library Ip_solve.
Ip_solve is a free library under the LPGL license (Lesser Public General License) of the Free Software Foundation.

Details on the licensing can be found at http:/Ipsolve.sourceforge.net/5.5/LGPL.htm
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Autofac, Copyright (c) 2017 Autofac Project

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject
to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Castle.Core, Copyright 2004-2017 Castle Project

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License.
You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless required by applicable law or agreed to
in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF
ANY KIND, either express or implied. See the License for the specific language governing permissions and limitations under the
License.

Apache log4net, Copyright 2004-2017 The Apache Software Foundation

This product includes software developed at The Apache Software Foundation (http://www.apache.org/). Licensed under the Apache
License, Version 2.0 (the "License"); you may not use this file except in compliance with the License. You may obtain a copy of the
License at http://www.apache.org/licenses/LICENSE-2.0 Unless required by applicable law or agreed to in writing, software
distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either
express or implied. See the License for the specific language governing permissions and limitations under the License.

NHibernate, Copyright (c) The NHibernate Project

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation (version 2.1). This library is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU Lesser General Public License for more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301
USA

Fluent NHibernate, Copyright (c) 2008-20012, James Gregory and contributors

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of James Gregory nor the names of its contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

HIiCAD uses the EPLUS library. This is a free library which is licensed under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation.

Further information on the licensing can be found under http://epplus.codeplex.com/license.
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System Requirements

1 System Requirements

Please note:

FIG turns into FGA

HiCAD 2017 comes with the new 2-D figures archives with the file name extension .FGA. Please use only
this new .FGA format for conversion of existing 2-D .FIG files! For this purpose, use the new
Converter_FIG_To_FGA.exe tool in the HiCAD\exe directory.

When updating to HICAD 2017 all standardly supplied 2-D parts (e.g. drawing frames) in the different
installation directories will be converted from FIG to FGA by default during the installation. The data in the
original state will be saved in a folder (resp. a ZIP archive) in the scene and catalogue directory. The
converted files will be documented in a LOG file.

When creating an interface between HICAD 2017 and HELIOS, you will be prompted to update the
databases after a new installation or an update installation. The search for and management of 2-D parts will
only be possible after conversion of the database and the existing .FIG files with the above mentioned tool.

Licences

We recommend deactivating local licenses and network licenses before performing an update/upgrade of
the operating system (e.g. from Windows 8 to Windows 10), and activating them again after successful
update/upgrade of the operating system.

Data Format

HICAD 2017 (Version 2200) uses a different data format, i.e. .SZA files created with HICAD 2017 cannot be
loaded in older HICAD versions.

1.1 Hardware Requirements for HiCAD

For the installation of HICAD you can use any hardware that possesses current drivers for the operating
systems used. Please note, for instance, that the graphics card drivers need to support the complete
OpenGL instruction set. You also require a DVD drive.

Hardware requirements (minimum)

Processor (CPU): Intel or AMD processor with SSE2 support

RAM: 4 GB RAM

Hard disk: approx. 5 GB free disk space

Screen resolution 1280 x 1024

Graphics card: Fully OpenGL 2.0 capable graphics card with at least 128 MB memory.

You can use the OpenGLCapabilityTester to check whether the OpenGL
capabilities of your computer are sufficient for HICAD.

Supported operating | Windows 10
systems: Windows 8

Windows 7 (with current service pack and security patches)

Other: For the output of reports, e.g. Sheet Metal cost calculations, you require
Microsoft Office Version 2010 or higher.



https://wiki.isdgroup.com/download/attachments/32374804/OpenGLCapabilityTester.exe?version=1&modificationDate=1346699841077
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(O To achieve optimal performance for large assemblies, the system should possess significantly more main
memory than is considered sufficient for HiCAD at first glance. This enables the hard disk accessing operations
Buffer memory, Undo and Switch drawing to be performed up to 4 times faster.

»  Supported database systems (for HICAD with HELIOS):
= Microsoft SQL Server 2008 / 2012 / 2014 / 2016
» Oracle Database Server 11gR1/11gR2/12c

There are no further requirements for the installation of the HICAD Version with License Management; the
legal licensing check is performed during runtime.

Recommended hardware equipment (October 2017)
Computer: Fujitsu CELSIUS W570

Processor (CPU): Intel® Core™ i7-7700-Processor, 8 MB, 4,2 GHz or
Intel® Xeon® Processor E3-1280v6, 8 MB, 4,2 GHz or
equivalent processor

RAM: 4 x 8 GB, DDR4, 2.400 MHz (incl. ECC)

If you work with very large CAD drawings it could be recommendable to use
computers with more RAM.

Hard disk: 1 x512 GB, SSD SATA IIl Premium bay, 2,5 inch
Graphics card: NVIDIA Quadro M2000 (4 GB)

Screen resolution Full HD (1920x1080)

Operating system: Microsoft Windows 10 (64 Bit)

Other: Microsoft Office Version 2010 or higher.

O Please note that insufficient graphics hardware will impair the performance and the quality of graphical
representation!
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1.2 System Requirements for HELiOS Desktop (Standalone)

For the installation of HELIOS you may use any hardware possessing current drivers for the operating
systems used. Please note, for instance, that the graphics card drivers need to support the complete
OpenGL instruction set. Furthermore, a DVD drive is required.

Minimum Hardware Requirements for HELiOS Desktop (Stand alone)

Processor (CPU): Intel or AMD processor with SSE2 support

RAM: 1 GB RAM

Graphics card: Graphics card according to CAD system or Viewer requirements

Operating system: Windows 10, Windows 8 or Windows 7 (with current service pack and
security patches)

Database systems: Microsoft SQL Server 2008 / 2012 / 2014 / 2016
Oracle Database Server 11g R1/11g R2/12c

Recommended hardware for HELIOS Desktop with simultaneous HiCAD operation
Computer: Fujitsu CELSIUS W570

Processor (CPU): Intel® Core™ i7-7700-Processor, 8 MB, 4,2 GHz or
Intel® Xeon® Processor E3-1280v6, 8 MB, 4,2 GHz or

equivalent processor

RAM: 4 x 8 GB, DDR4, 2.400 MHz (incl. ECC)

Hard disk: 1 x 512 GB, SSD SATA Il Premium bay, 2,5 inch
Graphics card: NVIDIA Quadro M2000 (4 GB)

Screen resolution Full HD (1920x1080)

Operating system: Recommended Microsoft Windows 10 (64 Bit)

Windows 10, Windows 8 or Windows 7 (with current service pack and security
patches)

» Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed on the computer
before HELIOS can be used; these packages will be installed by the HELIOS installer if required.

» To be able to work with HELIOS, a database system must be available that has been prepared for
HELIOS. For this you require

= A Microsoft SQL Database Management system on your Server,
» A HELIOS database imported with the HELIOS Database Creator and
= An ODBC connection on the Clients.

Documents (in .pdf format) describing the installation procedure for the database system and the import
and export of the database can be found in the Wiki at Product Know-how > Documentation > HELIOS.
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1.3

System Requirements for HELIOS Database

As of HELIOS 2017 you can use the following Server types as Database Servers (RDBMS):

»  Microsoft SQL Server, Versions 2008 - 2016

»  Oracle Database Server, Versions 11g R1 - 12c.

The requirements with regard to the hardware primarily depend on the specifications given by the respective
RDBMS supplier (Microsoft / Oracle).

The following recommendations are meant to serve as a rough guideline:

Operating Microsoft Windows Server Version 2008 (64 Bit) or higher

system

Processor Intel Pentium 1V, Intel Xeon, AMD Opteron, AMD Athlon 64

RAM At least 4 GB (with an increasing database size the RAM should also be increased to

ensure optimum performance)

Mass storage Mass storage device: 10 GB available hard disk space (absolute minimum; the actual
device

demand depends on the database size)

Graphics Standard, SVGA or higher

O Please note:

Virtual Servers are generally supported; it is important, though, that all requirements of the RDBMS
suppliers are strictly observed. For performance reasons we recommend using native computers.

For safety reasons domain controllers should not be used simultaneously as Database Servers or other
Servers.

The HELiOS Database Server, the HELiOS Vault Server and the ISD License Server can he installed and
run simultaneously on one computer. However, the database should not lie on the same RAID system as
the Vault. The Vault requires large harddrives while the database requires fast harddrives.

If possible the Database Server should not be connected to the network with more than one network
card.

For safety reasons the HELiOS Spooler should not be run together with a HELiOS Database Server or a
Vault Server on one computer.
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1.4 Hardware Requirements License Server

Processor (CPU):

x86 Processor for 32-Bit / x86-64 Processor for 64-Bit

Recommended: 2 GHz Processor

RAM: Minimum: 1 GB
Recommended: 2 GB (with SQL Server: > 3 GB )
Hard disk: 1.2 GB free disk space

Operating System (Server)

Windows 10

Windows 8

Windows 7 (32 & 64-Bit)

Windows Server 2016

Windows Server 2012

Windows Server 2008 (32 & 64Bit)
Windows Server 2008 R2 (32 & 648Bit)

IP/MAC Adress

A static IP address is required for an error-free operation of the license
server.

For virtual servers a static MAC address needs to be available.

O Please note:

= Alicense server program needs not necessarily run on a fileserver system or on a special hardware
server; suitable will be any computer fulfilling the above-mentioned requirements.

= The license server must not be installed on the same computer as the ISD product (e.g. HICAD/HELi0S)
as both programs share system information regarding the licensing.

= Aninternet access is needed on the computer/server on which the licenses are managed.
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1.5 Hardware Requirements HiCAD Spooler

The system requirements for the Spooler are identical to those for a normal HICAD Client (please see
System Requirements for HICAD). The RAM should be at least as large as the RAM for the existing HICAD
Clients. The reason for this is that the Spooler must be able to perform, besides automation tasks, various
other tasks such as the conversion of HICAD drawings (to 3D-PDF or similar).

Besides the Client operating systems Windows 7, 8 and 10 you can also use the Server operating systems
Windows Server 2008 or Windows Server 2012. Whether a Server operating system needs to be used
depends on the licensing conditions for the Microsoft operating system that you use. The decisive factor is
the number of permitted simultaneous device connections.

»  Windows 7, 8 and 10 allow 20 simultaneous connections. This will be sufficient for 20 Print Clients, if all
of them are actually running at the same time. Please note however that each connection from a non-
HICAD/HELIOS workstation will reduce this number.
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1.6 Hardware Requirements HELiOS Spooler

Important Update note!

As of HELIOS version 2015 a new HELIOS Spooler is supplied. As it is an entirely new software, an update of
the old Spooler is not possible.

Before installing the new HELIOS Spooler, please make a record of the old Spooler’s settings, uninstall it,
and then adjust the settings of the new Spooler accordingly.

Further information can be found in the HELIOS Help.

The system requirements for the HELIOS Spooler are analogous to those of your CAD system. The RAM
should be at least as large as those of the utilized CAD systems. The reason for this is that the Spooler may,
besides its automation as a Plot Server, also be used for other tasks, such as conversion of HICAD drawings
(e.g. to 3D-PDF if HICAD is the CAD system).

Besides the Client operating systems Windows 7, 8 and 10 the Server operating systems Windows Server
2008 or Windows Server 2012 can be used. Whether a Server operating system is to be used depends on
the license conditions for the utilized Microsoft operating system. Here, the number of allowed,
simultaneous device connections is decisive.

»  Windows 7 and 8 allow 20 simultaneous accesses. This is enough for 20 Print Clients provided that all
of them had actually been started. Please note however that each connection from a non-workstation
will reduce this number accordingly.

Recommended hardware for HELIOS Spooler in conjunction with HICAD
Computer: Fujitsu CELSIUS W570

Processor (CPU): Intel® Core™ i7-7700-Processor, 8 MB, 4,2 GHz or
Intel® Xeon® Processor E3-1280v6, 8 MB, 4,2 GHz or

equivalent processor

RAM: 4 x 8 GB, DDR4, 2.400 MHz (incl. ECC)

Hard disk: 1 x512 GB, SSD SATA Il Premium bay, 2,5 inch
Graphics card: NVIDIA Quadro M2000 (4 GB)

Screen resolution: Full HD (1920x1080)

Operating system: Microsoft Windows 10 (64Bit)

Database system: See Compatibility Matrix
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1.7 Hardware Requirements HELiOS Vault Server

Processor (CPU):

Pentium Ill-compatible processor, Minimum: 1,0 GHz

RAM:

Minimum: 1 GB, Recommended: 4 GB or more

Graphics card:

VGA (no special requirements)

Hard disk: For software: 100 MB
For user data: Depending on the amount of data to be expected, plus backup
memory of >= 100%
(distribution over several volumes/drives possible, redundant array of
independent disks (RAID) for primary user data recommended)

Operating system | Windows 10

(virtual servers also
possible):

Windows 7 Professional
Windows 7 x64 Professional

Windows 8 Professional
Windows 8 x64 Professional

Windows Server 2008 SP2
Windows Server 2008 SP2 x64

Windows Server 2008 R2 x64
Windows Server 2012
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1.8 Hardware Requirements HELiOS Smart Search

See Hardware Requirements HELIOS Vault Server
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1.9  Further Installation Requirements

»  Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed on the computer
before HICAD/HELIOS can be used; these packages will be installed as part of the HiICAD installation if
required.

»  The graphics card must support Open GL 2.0 or higher. If the hardware or driver does not support this
standard, there will be shown a warning message when installing HICAD and a compatibility mode will
be used (with low graphic performance).

» To be able to work with HELIOS, a database system must be available that has been prepared for
HELIOS. For this you require

= A Microsoft SQL Database Management system on your Server,
= A HELIOS database imported with the HELIOS Database Creator and
= An ODBC connection on the Clients.

Documents (in .pdf format) describing the installation procedure for the database system and the import
and export of the database can be found in the Wiki at Product Know-how > Documentation > HELiOS.

Current information on system requirements can also be found on the Internet at www.isdgroup.com at
Support > ISD Wiki > Product know-how > FAQ.
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2 Installation

The DVD contains the installation files for:

» HiCAD

» HELIOS Desktop (Standalone)

»  The Online Help

»  The HELIOS Vault Server

» The HELIOS SmartSearch Server
»  The HIiCAD Spooler

» The HELIOS Spooler

» HiCAD Viewer

» The License Server (the Hardlock driver is normally no longer required)

»  The PostScript printer driver (required for the output of several views to a PDF file)

» The HELIOS Database creator (to set up the HELIOS database for the very first time and import/export

an existing database)

The DVD has been developed for Windows operating systems. When you insert the DVD, an installation

wizard will be started automatically.

© The HiCAD and HELiOS version must be installed on the hard disk of the computer; it is not possible to start

the programs from the DVD.

If the Autostart function has been deactivated in the operating system, it is mandatory for the installation of
HICAD to start the setup.exe file from the root directory of the DVD; only in this way it is ensured that the
version will recognize the operating system, and that the matching HiCAD version will be installed.

3 15D Installation 2017 =5
—

- Standard Edition ‘

y Trial Edition \

< Education Edition ‘

-
5
© 1085 - 2017 I1SD Group. All rights reserved

In the installation wizard, click the Standard Edition button, which opens a mask with various selection

options for software components.
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r
™ HiCAD 2017 (x64 2200.0), HELIOS 2017 (x64 2200.0) DB Version 145

HELIOS Database Creator |

h Installation Documents Client Installations
— HICAD - ion Notes | HICAD and HELIOS |
= Program support HiCAD Viewer |
N Lﬂmﬂmﬂuhwwa%hw HELIOS |
HICAD and HELIOS Help | PostScript Printer |

- HICAD Viewer Help | Server Installations
HELIOS Desktop Help | HELIOS Intemet Server |

o Tooks | HELIOS Spooler |

ent may only be installsd on the License HiCAD Spooler |

SafeNet License-Server © HELIOS SmartSearch Server I

HELIOS Vault Server |

|

HELIOS Application Server

FIG-FGA Converter I

© 1985 - 2017 ISD Group. Al rights reserved.

Leave this selection mask open, so that you can select the desired components one after the other.
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2.1 Installing HiICAD

L P Installation Documents Client Installations
— HICAD - Installation Notes | HICAD and HELIOS |
( | Program support HICAD Viewer |
N mmm Help files is only raquirad if thers is no HELIOS l
HICAD and HELIOS Help | PostScript Printer |
HIiCAD Viewer Help | Server Installations

HELIOS Desktop Help | HELIOS Internet Server

Administrator Tools HELIOS Spooler

This component may only be installad on the License Samyer HiCAD Spooler |
SafeNet License-Server I HELIOS SmartSearch Server |

HELIOS Database Creator | HELIOS Vault Server
FIG-FGA Converter | " HELiOS Application Server
N

Click the HICAD and HELIOS button to start the installation.

Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to be installed on the
computer before HICAD/HELIOS can be used; these packages will be installed as part of the HICAD
installation if required.

-
) HICAD 2017 EN Setup o

Welcome to the HICAD 2017 EN Setup
Wizard

The Setup Wizard will install HICAD 2017 EN on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.

g B
ﬁ HICAD 2017 EN Information = | —
Setup Information
I . 5 . " *. |
Flease note the following impartnat information Al s =

Flease read the compatibility information about the =
file and database format. This information is eithex| |
supplied with the software or can be downloaded from

the ISD Homepage. L

During conversion to the current HiCAD version, the
format of the 2-D part files will be converted from
FIG to FGA.

The conversion of the files that are supplied by
default takes place during installation. Before
conversion, the data will be backed up in their
original state at fig2fga backup in the local HICAD
SZENEN directory. S

Back ][ Mext ] [ Cancel

First, important information about data compatibility will be displayed. Please read this information carefully.
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r hl
ﬁ HICAD 2017 EN Setup El;lg
Destination Folder
Please select the installation folder @

Install HICAD 2017 EN to:

IC:\,HiCAD‘\

Back ][ Next ] [ Cancel

Specify an installation directory.

M B
) HCAD 2017 EN setp ol
Optimisation of user-friendliness @

‘fou can help us increase the user-friendliness of our products even further, To
participate or terminate your participation, please activate the corresponding checkbox
shown below

‘Yes, I hereby give my consent for the transmission of data on the
functionalities that I use to the ISD. For further information please read our
Data Protection notes.

[] Mo, Idonotwant to participate.

‘fou can terminate your participation at any time by choosing Help = Customer
Feedbadk, and selecting the corresponding checkbox

Back ][ Mext J I Cancel

You can help us increase the user-friendliness of our products even further. To participate or terminate your
participation, please activate the corresponding checkbox.

You can terminate your participation at any time by choosing Help > Customer Feedback, and selecting the
corresponding checkbox.
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Data Protection notice: Collection of Data for Constant GUI Optimisation

You can help us increase the user-friendliness of our products even further. If you participate, the ISD will
collect information on your use of our software, in order to detect trends and use patterns. This information
will then be used for a constant optimisation of our user interface, with the aim to make the operation of our
software as convenient and efficient as possible for our users.

The collected information
Contains data on the functions that you used (frequency and chronological order).

Contains a key enabling the identification of your computer. It does not contain any personal data, and will
not be used to detect your identity. The key will only be used to obtain data on the diffusion rate of customer
feedback. For instance, it is important to know whether a functionality has been used 100 times by 1
customer, or whether another function has been used only once by 100 customers etc.

Will be automatically removed after transmission to the ISD. In case of a failed transmission (e.g. because of
network problems) the information will be automatically removed after 1 week at the latest when the
program has been re-launched.

Will not cause a slowing down of the program operation.

ISD will not

Store your name, address, or any other personal data.

Ask any further questions besides asking for your consent to the participation.
Use the data for any other purposes than those described above.

Contact you in any form in connection with your participation.

You can choose to participate when installing the product for the first time. To terminate your participation at
a later time, choose Help > Customer Feedback, and select the corresponding option.

5] HiCAD 2017 EN Setup = | o |
License Management
License Motes and Settings | /‘E |
Notes on Hardware Exchange -

If you use local HiCAD/HELiOS/HELiCCN licenses and
want to exchange any hardware components, modify the
partitioning of, or re-install the operating system,
you need to revoke the existing license on the HiCAD
workstation first, and request, using the new
hardware or modified configuration, a new license
key (further information on the procedure can be
found in the software documentation).

1 accept the Notes on License Management

Back J[ Mext ] { Cancel

Please read the Notes on Hardware exchange carefully.
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Notes on Hardware Exchange

If you use local HICAD/HELIOS licenses and want to exchange any hardware components, modify the
partitioning of, or re-install the operating system, you need to revoke the existing license on the HiCAD
workstation first, and request, using the new hardware or modified configuration, a new license key (further
information on the procedure can be found in the software documentation).

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs
in an appropriate amount for the reissuing of the license. If the license will not be revoked, or if such
revocation is no longer technically possible, the ISD may request proof that the unrevoked license is no
longer utilisable; in case of failure to produce such proof, the ISD reserves the right to refuse the transfer of
the license to a new hardware.

Accept the notes and click Next.

r ~
5] HICAD 2017 EN Setup = LX)

Parameter configuration

Selection of standard configuration template | /‘D |
Modul Font

@ Mechanical Engineering @) HICAD

~ Steel/Metal Engineering ) Arial

_) Plant Engineering
[ Attribute configuration acc, to DSTY [ Management + BIM

HICAD f HELIOS Default Solution
Movice configuration

[ Back ][ MNext ] [ Cancel ]

For different drawing areas HiCAD offers especially adjusted surfaces and configurations, e.g. for
Mechanical Engineering, Steel Engineering and Plant Engineering. These can be selected during the
installation of HICAD.

Depending on the parameter configuration the saved settings in the CSV file will be applied, too. The CSV
file contains information on e.g. which files (e.g. HICAD part masks or template files for labels) should be
copied into the sys directory. In case of an update different system files in the HiCAD sys directory will be
replaced — without further inquiry — by file supplied in the HiCAD templates directory, which are specifically
adjusted to the chosen modules and activated checkboxes (e.g. DSTV or Management + BIM).

Via Extended Settings you can change the parameter configuration once more and select your own template
files.

Select a module for the parameter configuration and click Next.
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5] HiCAD 2017 EN Setup = e S
Ready to install HICAD 2017 EN [J B N

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Extended settings

Back ][ Install ] [ Cancel

You can now start with the installation or modify the Extended Settings, e.g. for the user configuration, the
catalogues, or HICAD with HELIOS.

ﬁ Extended settings =NACE X
| HELIOS Interfaces I LogiKal Interface | General
User Configuration | Catalogue | HELIOS

Configuration database  C:\ProgramData\ISD Software und Systeme\HiCAD 201@
Install database

Parameter configuration @ Default templates : -~

_) Own templates Maodule Font
@ Mechanical Engineering @ HIiCAD
_) Steel/Metal Engineering - Arial

_) Plant Engineering

[7] Attribute configuration acc. to DSTV [C] Management + BIM
HICAD / HELIOS Default Sclution
Movice configuration

@ Save Cancel

In the Configuration Database, customer-specific settings for various features such as dimensioning,
annotations, workshop drawing creation or fitting of vertical ladders are stored. When performing an update,
customer-specific settings can be applied. In addition, values that have not been modified by the user will
automatically obtain the updated pre-settings.

In the Parameter configuration you can modify previously activated default templates. Moreover, you can
select CSV files via Own templates. The settings stored in the CSV file, too, will be applied. In a CSV file it is,
amongst other things, specified which files (e.g. HICAD part masks or template masks for annotations) are to
be copied to the sys directory. When performing an Update, various system files in the HICAD sys directory
will be replaced with the files supplied in the HICAD templates directory which have been designed
especially for a working with the selected module and the activated checkboxes (e.g. ...DSTV or
Management + BIM). The standard CSV files are located in the templates directory of the HICAD installation.
CSV files are configuration templates that you can create and edit with Microsoft Excel (please see Online
Help).

Parameter configuration: No templates is activated by default in Parameter Configuration. You can also
change this setting subsequently, via the programs ..exe/ParKonfigComp.exe (for the workstation) and
..exe/ParKonfigUser.exe (for the User).
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j@ Extended settings =NREN X
HELIOS Interfaces | LogiKal Interface | General
User Configuration | Catalogue | HELIOS
Catalogue directory }C:'\,HiCAD\Katange E]

Copy catalogues to default directory

Execute CatalogueMaker DIN ISC -
[C] nteractive

[C] Execute Catalogue Update  Previous version |0

Interactive

Overwrite write protected files
Retain own settings
Delete backup copies

Show log

Save Cancel

The execution of the CatalogueMaker serves the purpose of specifying which standard series are to appear
in the standard part catalogues (currently standard series are available for DIN, 1SO, EN, ANSI and JIS); the
selection of standards in the CatalogueMaker only influences the display of standard parts, but not their
availability; the availability is still controlled via license selection in the ISD License Manager.

In case of updates, the existing configuration will be applied, and the CatalogueMaker will not be started
automatically. If you want to add standards to the catalogues, the program can be called via Start > All
Programs > ISD Software und Systeme GmbH > Administration.

ﬁ Extended settings = | S

HELIOS Interfaces | LogiKal Interface | General |
User Configuration | Catalogue | HELIOS

System data source HeliosBauteil

User hicad

Password sssss

Use Vault Server Address localhost Port 9000

SmartSearch-Server [C] Activate

Configuration
Use Spooler Server localhost

[C] Use Application Server Address Port

Save Cancel

In case of a new installation of HELIOS you can specify an arbitrary name for the system data source. In
case of an update, the existing data source will be offered. User and Password will be identical with the
ODBC login.

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address
input field, and the Server Port of the Vault Server in the Port input field. You already entered both during
the installation of the Vault Server.

If you have not installed the Vault Server yet, you can do this now: Choose HELIOS Options > Database >
General > Vault Server IZI )

During an update installation it will be checked whether the existing HELIOS version is newer than the one
on the DVD. If this is the case, the HiICAD installation will only update the non-HELIOS files. The HELIOS files
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are those that would be supplied by a standalone installation of the HELIOS Desktop, minus the
hicadcommons contained therein.

If you want to process your print jobs via the ISD Plot Management, you need to install one PrintClient on
each workstation. Activate Use Spooler. In the Server field, enter the network name of the computer on
which the Spooler is installed. The Spooler collects the print jobs and processes them, taking your settings
into account.

Individual settings for the HELIOS surface can be transmitted to additional users and computers. To do so,
create a ZIP file in HELIOS via View > Settings > Export. During the installation you can select and import
the surface configurations for the HELIOS desktop under Ul configuration.

-
Iﬁ] Extended settings = | B ||
‘ User Configuration | Catalogue | HELIOS
HELIOS Interfaces | LogiKal Interface | General
Office
Excel
[ Outlook 32 bit
[C] PowerPaint @64 bit
Word
Sonstige
EPLAN
Save | Cancel |

The availability of interfaces with HELIOS depends on the programs that are installed on your computer.
With the exception of the HELIOS interface, you can only use 32Bit versions with HELIOS 32Bit, and 64Bit
versions only with HELIOS 64Bit. For MS Office it is generally possible to use a 32Bit Office with HELIOS
(64Bit). However, for old BOMs an additional, special ODBC connection will be required. In such cases,
please contact our Consulting team.

Multiple selections are also possible. The HELIOS functions will be integrated in the programs that are linked
to HELIOS.

O Please note:

= A compatibility matrix of the CAD systems can be found in the Wiki, at Product Know-how > FAQ >
System & Hardware > HELi0S Desktop.

= Integration of shared networks
If a directory is accessed by more than one computer, in the filegrup.dat under C: (for the Scenes
directory) should not be listed a local path or the network connection letter, but the entire UNC path
according to the pattern
C:\\servername\ShareName\Directory

The filegrup.dat can be found in the HiCAD/HELiOS installation in the HiCAD exe directory and in case of
an EPlan interface as well under HELiOS EPlan SyncService\exe. In the HELiOS Standalone installation
the filegrup.dat can be found in the HELiOS exe directory.
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~
ﬁ Extended settings =NRC X
User Configuration | Catalogue I HELIOS
HELIOS Interfaces | LogiKal Interface | General
LogiKal directory | CALOGIKAL O
Save Cancel

If you have installed LogiKal on your computer, you can enter the installation directory here.

[ hl
5 Extended settings SARCN X
User Configuration | Catalogue | HELIOS |
HELIOS Interfaces | Logikal Interface | General

Installation directory | C:AHICADY

Update-Installation

Save Cancel

The Activate license administration tools must be activated for the installation of server licenses.

Click Save to save the Extended Settings to an INI file. If you place the INI file in the installation directory
when installing server licenses, the settings will be applied.

As soon as you exit the Extended Settings dialogue with OK, the installation will be started.

O In HiCAD, at Settings > Further directories you can set the paths for the database of the Configuration
Editor, the Catalogue directory and LogiKal. These paths are located in the Windows Registry at
HKEY_LOCAL_MACHINE\SOFTWARE\ISD Software und Systeme\HiCAD\nnnn.n.
nnnn.n is the HiCAD version number, e.g. 2200.0.
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) HICAD 2017 EN Setup .

Installing HiICAD 2017 EN

~
) HICAD 2017 EN Setup Y

Completed the HICAD 2017 EN Setup
HIGAD e
2 n ] 7 Click the Finish button to exit the Setup Wizard.

[ ek J{_Fosh J [ Concel |

Click Finish to complete your HICAD installation. If desired, you can use the buttons of the installation mask
to install further software components.
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2.2 Installing HELiOS Desktop (Standalone)

The HELIOS Desktop is normally installed automatically when you install HICAD. Of course, you can also
install HELIOS separately. To do this, start Windows. If Windows is already open, close all other applications.
Insert the HELIOS DVD in your DVD drive. The installation wizard will be started automatically. Follow the
instructions on the screen.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection
options for software components. Please leave this selection mask open, so that you can, one after the
other, install the desired components.

=

Installation Documents Client Installations
— HICAD - Installation Notes | HICAD and HELIOS |
= Program support HICAD Viewer I
N ?mmz#ﬂﬂpﬂesisMyﬁqum if there is no HELIOS |
HICAD and HELIOS Help | PostScript Printer |
HICAD Viewer Help | Server Installations
HELIOS Desktop Help | HELIOS Internet Server
Administrator Tools HELIOS Spooler

This component may only bs installad on the Licenss Saryer! HIiCAD Spooler |
SafeNet License-Server - I HELIOS SmartSearch Server |
HELIOS Database Creator | HELIOS Vault Server |
FIG-FGA Converter | HELIOS Application Server |
N
Click the HELIOS button.
("8 HeLios 2017 setup [ESREER)

ll-l '7: S w;l;:?;'ie to the HELIOS 2017 Setup
2017

The Setup Wizard will install HELIOS 2017 on your computer.
Click Next to continue or Cancel to exit the Setup Wizard.

Back [ Next ] [ Cancel
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\
) HELIOS 2017 Setup = X

Destination Folder

 —
‘ L] .
Please select the installation folder |

Install HELIOS 2017 to:

|C: \Program Files\ISD Software und Systeme\HELIOSY

Badck ][ Next l [ Cancel

Select an installation directory.

In accordance with the current Microsoft guidelines, the HELIOS documents will be saved to
C:\Users\Public\Documents\ISD Software und Systeme\ in case of a new installation. Only the Administrator
has write permissions for the installation directory (C:\ProgramFiles\..).

If you work on several workstations without a Vault Server, you need to enter on each workstation the path of
the document directory into the system file FILEGRUP.DAT. This means that the default path needs to be
changed accordingly in all corresponding placed of the FILEGRUP.DAT. The directory should be a shared
network directory to which all Clients have access.

2 HELIOS 2017 Setup = X

License Management

License Motes and Settings

E

NHotes on Hardware Exchange

If you use local HiCAD/HELiOS/HELiCON licenses and
want to exchange any hardware components, modify the
partitioning of, or re-install the operating system,
you need to revoke the existing license on the HiCAD
workstation first, and request, using the new
hardware or modified configuration, a new license
key (further information on the procedure can be
found in the software documentation).

[¥11 accept the Notes on License Management:

Back ][ Mext ] [ Cancel

Please read the Notes on Hardware Exchange carefully.

Notes on Hardware Exchange

If you use local HICAD/HELIOS licenses and want to exchange any hardware components, modify the
partitioning of, or re-install the operating system, you need to revoke the existing license on the HiCAD
workstation first, and request, using the new hardware or maodified configuration, a new license key (further
information on the procedure can be found in the software documentation).

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs
in an appropriate amount for the reissuing of the license. If the license will not be revoked, or if such
revocation is no longer technically possible, the ISD may request proof that the unrevoked license is no
longer utilisable; in case of failure to produce such proof, the ISD reserves the right to refuse the transfer of
the license to a new hardware.

Accept the notes to continue with the installation.
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r <
] HELIOS 2017 Setup = e e

Ready to install HELIOS 2017 ‘i n m' I ~ g -
_

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Extended settings

Back ][ Install ] [ Cancel

You can now start with the installation or modify the Extended Settings, e.g. for HELIOS.

‘ﬂ Extended settings =NECE X
HELIOS | HELIOS Interfaces | General |
System data source HeliosBauteil
User hicad
Password sssee
Use Vault Server Address localhost Port 9000
SmartSearch-5erver [C] Activate

Configuration

[l Use Spooler ! Server localhost
[T] Use Application Server  Address Port
UI Cenfiguration D

Save| Cancel|

In case of a new installation you can specify an arbitrary name for the system data source. In case of an
update, the existing data source will be offered. User and Password will be identical with the ODBC login.

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address
input field, and the Server Port of the Vault Server in the Port input field. You already entered both during
the installation of the Vault Server.

If you have not installed the Vault Server yet, you can do this now: Choose HELIOS Options > Database >
General > Vault Server [... 1.

If you want to process your print jobs via the Plotmanagement of the ISD, you need to install a Print Client
on each workstation. Activate Use Spooler. In the Server field, enter the name of the computer on which you
install the Spooler. The Spooler collects the print jobs and processes them according to your settings.

Individual settings for the HELIOS surface can be transmitted to additional users and computers. To do so
create a ZIP file in HELIOS via View > Settings > Export. During the installation you can select and import
the surface configurations for the HELIOS desktop under Ul configuration.
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ﬁ Extended settings =ANCN X

-HELiOS HELIOS Interfaces | General

Microsoft Office®
[E] Excel
[C] Qutlook 7 32 bit

[T PowerPoint ©i64 bit
‘Word

CAD

AutoCAD®
Inventor®
SOLIDWORKS®

Others
EPLAN

*As of Version 2012. Older AutoCAD versions can be linked to HELIOS as well. Further information
can be found in the Online Help.

Save Cancel

The availability of interfaces with HELIOS depends on the programs that are installed on your computer.
With the exception of the HELIOS interface, you can only use 32Bit versions with HELIOS 32Bit, and 64Bit
versions only with HELIOS 64Bit. For MS Office it is generally possible to use a 32Bit Office with HELIOS

(64Bit). However, for old BOMs an additional, special ODBC connection will be required. In such cases,
please contact our Consulting team.

Multiple selections are also possible. The HELIOS functions will be integrated in the programs that are linked
to HELIOS.

() Please note:

= A compatibility matrix of the CAD systems can be found in the Wiki, at Product Know-how > FAQ >
System & Hardware > HELi0S Desktop.

ﬁ Extended settings SARCE X

[ HELOS | HELIOS Interfaces | General |

Installation directory | C:\Program Files\ISD Software und Systeme\HELIOS\
Update-Installation

Activate license administration tools :

Save Cancel

You require the License Administration Tools for the installation of server licenses.

Click Save to save the Extended Settings to an INI file. If you place the INI file in the installation directory
when installing server licenses, the settings will be applied.

Close the Extended Settings dialogue with OK and start the installation.
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-
4 HELIOS 2017 Setup ==

I"mm"g HELIOS 2017 @

Please wait while the Setup Wizard installs HELIOS 2017.

Status:

Back || Mext | l Cancel I

1) HELIOS 2017 Setup.

Completed the HELIOS 2017 Setup
Wizard

Click the Finish button to exit the Setup Wizard.

After successful installation, you will find the HELIOS shortcut on the Desktop for program launch.
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2.3 Installing the Online Help

The Online Help is available locally (status of the date of installation DVD creation) and on the Internet
(regularly updated) at www.help.isdgroup.com. Both versions of the Help can be directly launched from
HICAD. Please note that corresponding login data are required to access the Internet version of the Help.

Start Windows to install the Help. If Windows is already open, close all other applications. Insert the DVD in
the drive, which automatically starts the installation wizard. In the installation wizard, click the Standard
Edition button, which opens a mask with various selection options for software components. Please leave
this selection mask open, so that you can, one after the other, install the desired components.

L Installation Documents Client Installations
— HICAD - Installation Notes | HICAD and HELIOS |
= Program support HICAD Viewer |
N ;:‘L:t:lm:ﬂn}lelp files is only required if there is no HELIOS |
HICAD and HELIOS Help | PostScript Printer |

HICAD Viewer Help | Server Installations

HELIOS Desktop Help | HELIOS Internet Server |

A - e LIEiAS e i |

Click the HiCAD and HELiOS Help button.

[ Al
ﬁ] HiCAD Documentation Setup @_lg

Welcome to the HICAD Documentation
HICGAD s iao

The Setup Wizard will install HICAD Documentation on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.

Back [ Next ] [ Cancel

Specify the installation directory for HICAD/HELIOS.
r# HICAD Documentation Setup EI_Iﬂj

Destination Folder
Please select the installation folder @

Install HICAD Documentation to:

CiHICADY -
Back ][ Next ] [ Cancel
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Click Next.

-
ﬁ HIiCAD Documentation Setup =
Ready to install HICAD Documentation Ig . " LD
| =

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back || Instal ] [ cancel

Click Install to start the installation.

-
ﬁ HiCAD Documentation Setup =l

Completed the HICAD Documentation
HICGAD s wia
Zn ] 7 Click the Finish button to exit the Setup Wizard.

| Back Cancel

After successful installation, the Help can be found in the program folder and can be called via

HICAD/HELIOS.
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2.4 Installing the HELIOS Vault Server

Start Windows to install the Vault Server. If Windows is already open, close all other applications. Insert the
DVD in the DVD drive, which automatically starts the installation wizard. In the installation wizard, click the
Standard Edition button, which opens a mask with various selection options for software components.
Please leave this selection mask open, so that you can, one after the other, install the desired components.

O In rare cases an older, manually installed version of the VaultServer might be found, which will not be
modified (updated) as a precaution. If an error message appears, please contact our colleagues from the
Hotline. E-Mail: helpdesk@isdgroup.de

HILALD Viewer Heip | Server Installations
HELIOS Desktop Help | HELIOS Internet Server |
Administrator Tools HELIOS Spooler |
2 z&mmmyomsbeimmudmmLméiTe HICAD Spooler |
SafeNet License-Server I HELIOS SmartSearch Server |
HELIOS Database Creator ] HELIOS Vault Server |
FIG-FGA Converter | HELIOS Application Server |
™
Click the HELIOS Vault Server button.
'ﬁ! HELIOS Vault Server Setup o= )
Welcome to the HELIOS Vault Server
Setup Wizard
The Setup Wizard will install HELIOS Vault Server on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard.
Back [ Mext ] [ Cancel
rg! HELIOS Vault Server Setup e N

Destination Folder
Please select the installation folder

Install HELIOS Vault Server to:

IC:\Program Files\ISD Software und Systeme\HELIOS Vault Server),

Back || MNext | [ Cancel
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Specify the installation directory of the Vault Server.

r 5
5! HELIOS Vault Server Setup = LX)
Configuration mﬁa
LD U e
HELIOS Vault Server Settings
Server name |ISDVAULT
Server port |QDDD
Back ][ Next ] [ Cancel
.

Give the Vault Server a name, e.g. the name of your company, plus the location of your company. This name

will be shown, for example, when you connect to the Vault Server from the Vault Client.

r ~
2 HELIOS Vault Server Setup = o m
Configuration Wa
|l =
Server directories
Documents folder [CH\HELIOS Vault ISDVAULT \Documents|, (]
Management folder ‘C: HELIOS Vault ISDVAULT \Management [z]
Create filetable
Log folder ‘C:\HELiOS Vault ISDVAULT Logfiles) [z]
Logfile name ‘ISD\I'NJLT.'EIQ
Back |[ MNext ¢ [ Cancel

The Vault Server renames all documents that are managed in the database (e.g. SZA, DOC, XLS, ...) to
* VDF. These VDF files are saved to the Document directory.

The files stored in the Management directory contain the assignments of the VDF file names to the “original

file names”.

Log files (*.LOG) are saved to the Log directory. They record each access to the VDF files.

Enter the name of the log file in the Log file name field. The name of the Vault Server would also be possible

here. If the log file exceeds a certain length, it will be cut down and suffixed by the current date.

installation settings. Click Ca

Click Install to begin the installation. Click Back to review or change any of your

ncel to exit the wizard,

14 HELIOS Vault Server Setup (SN
Ready to install HELIOS Vault Server 'S0 E"‘

Back ][ Install J [ Cancel
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Click the Install button.

-
) HELIOS Vault Server Setup ==

Completed the HELIOS Vault Server
Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back |l Finish ] | Cancel

Click Finish to complete the installation of the Vault Server. You can now install further components offered
in the selection mask if desired.
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2.5 Installing the HiCAD Spooler

Start Windows to install the HICAD Spooler. If Windows is already open, close all other applications. Insert
the DVD in the DVD drive, which automatically starts the installation wizard. In the installation wizard, click
the Standard Edition button, which opens a mask with various selection options for software components.
Please leave this selection mask open, so that you can, one after the other, install the desired components.

HIiCAD Viewer Help ] Server Installations
HELIOS Desktop Help | HELIOS Internet Server |
et stor Tools HELIOS Spooler |
mmmmyuwummum%ay HICAD Spooler |
' SafeNet License-Server | HELIOS SmartSearch Server |
HELIOS Database Creator [ HELIOS Vault Server |
’ FIG-FGA Converter | HELIOS Application Server |
.
Click the HICAD Spooler button.
[ ) HICAD 2017 Spooler EN Setup = A

Welcome to the HiICAD 2017 Spooler EN
HIGAD s i

The Setup Wizard will install HICAD 2017 Spooler EN on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.

-
ﬁ HIiCAD 2017 Spooler EN Information =

Setup Information

Please note the following importnat information

File and database compatibiliity

Please read the compatibility information about the
file and database format. This information is either
supplied with the software or can be downloaded from|z=
the ISD Homepage.

| »

Conversion of 2-D part file format from FIG to FGA
During conversion to the current HiCAD wversion, the
format of the 2-D part files will be converted from
FIG to FGA.

The conversion of the files that are supplied by
default takes place during inscallacion. Before
conversion, the data will be backed up in their

Back ][ Next ] [ Cancel

First, important information about data compatibility will be displayed. Please read this information carefully.
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F
ﬁ HICAD 2017 Spooler EN Setup I

Destination Folder
Please select the installation folder

Install HICAD 2017 Spooler EN to:

IC:\,HiCAD Spooler

Back ][ Next ] [ Cancel
Specify the installation directory for the software.
"ﬁ HIiCAD 2017 Spoaler EN Setup =] = \
License Management
s D
License Motes and Settings iR S s =

IHotes on Hardware Exchange

| »

If you use local HiCAD/HELiCS/HELiCON licenses and
want to exchange any hardware components, modify the
partitioning of, or re-install the operating system,
vou need to revoke the existing license on the HiCAD
workstation first, and reguest, using the new
lhardware or modified configuration, a new license
key (further information on the procedure can be
found in the software documentation).

m

[V]1 accept the Notes on License Management:

Back ][ MNext ] [ Cancel

Please read the Notes on Hardware Exchange carefully. Accept the notes to continue with the installation.
rﬁ Extended settings @M

User Configuration |Cataingue I LogiKal Interface I General ‘

Configuration database  C\ProgramData\lSD Software und Systeme\HICAD ZOIE]
Instsll database

Parameter configuration @ Default templat £l
© Own templates | Module Font
@ Mechanical Engineering @ HiCAD
() Steel/Metal Engineering © Arial

() Plant Engineering

[T attribute cenfiguration acc. to DSTV | Management + BIM
HICAD / HELIOS Default Solution
Movice configuration

H

.

For different drawing areas HiCAD offers especially adjusted surfaces and configurations, e.g. for

Mechanical Engineering, Steel Engineering and Plant Engineering. These can be selected during the
installation of HICAD.

Select a module for the parameter configuration and click Next.
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P ™
8] HICAD 2017 Spaoler EN Setup [E=R ISR

Ready to install HICAD 2017 Spooler EN 3.4 ™

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Extended settings

Back ][ Install ] [ Cancel

You can now click Install to start the installation, or modify the Extended settings, e.g. for the user
configuration or the catalogues. The Extended Settings here are modified in the same way as the Extended
Settings for the HICAD.

Then click Install.

- \
1) HICAD 2017 Spooler EN Setup [E=SEE)

Completed the HiICAD 2017 Spooler EN
HIGAD s o
2 n ] 7 Click the Finish button to exit the Setup Wizard.

)
X
£ « \

After successful installation, the HICAD Spooler will be located in the program folder.
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2.6 Installing the HELiOS Spooler

Important note on installation!

As the HELIOS Spooler (as of HELIOS 2015, V 2000.0) is an entirely new software, an update of the old
Spooler is not possible. Before installing the new HELIOS Spooler, please make a record of the old Spooler’s

settings, uninstall it, and then adjust the settings of the new Spooler accordingly.

Further information can be found in the HELIOS Online Help.

The HELIOS Spooler is only available as a 64Bit version, and supports only 64Bit applications.

To install the HELIOS Spooler, please start Windows. If Windows has already been started, please close all
other applications. Insert the DVD in your DVD drive. The selection mask for various software components
will then be displayed. Leave this mask open, and install one after the other, the required software

components.

Click the HELiOS Spooler button.
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Installation Documents Client Installations
HICAD - Installation Notes I HICAD and HELiOS ]
Program support HiCAD Viewer |
? nu:e::mm Help files is only raquised if there is no HELIOS I
HICAD and HELIOS Help I PostScript Printer ]
HICAD Viewer Help | Server Installations
HELIOS Desktop Help I HELIOS Internet Server |
HELIOS Spooler ]
o Administrator Tools .‘\\ HICAD Spooler |
g u@mmm;ummmmnmm;' HELIOS SmartSearch Server |
~ SafeNetLicense-Server | o HELIOS Vault Server |
HELIOS Database Creator | HELiOS Application Server |
™
rﬁl HELIOS Spooler Setup == )

Welcome to the HELIOS Spooler Setup
Wizard

TSI

The Setup Wizard will install HELIOS Spooler on your
computer, Click Next to continue or Cancel to exit the Setup
Wizard.

Back

Cancel
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ﬁ HICAD 2017 EN Information

Setup Information
Please note the following importnat information ! @ 4

Flease read the compatibility information about the =«
file and database format. This information is either
supplied with the software or can be downloaded from
the IS5D Homepage.

m

During conversion to the current HiCAD wersion, the
format of the 2-D part files will be converted from | |
FIG to FGA.

The conversion of the files that are supplied by
default takes place during installation. Before
conversion, the data will be backed up in their
original state at fig2fga backup in the local HiCAD

SZENEN directorv. Sk

Back ][ MNext ] [ Cancel

Specify the installation directory for the software.

15 HELIOS Spooler Setup

Destination Folder
Please select the installstion folder

Install HELIOS Spooler to:

|C:\Drogram Files\ISD Software und Systeme\HELIOS Spooler’

Back ][ Mext ] [ Cancel

In the Service registration area you can choose between the options Local system and User account.

5 HELIOS Spooler Setup

=] e |

Configuration
HELIOS Spooler Settings

Service registration

|:| Interactive start

Start service upon installation

User Server\Spooleruser AutoCAD®
Password Inventor®

CAD Add-Ins

HICAD

SOLIDWORKS®

Data directory ‘D: \HELIOS Spooler Datal, E]

Create network share

[ Back ][ Mext ] [ Cancel ]

S

A part of the Spooler is started by the system as a background process (Windows service). For safety
reasons it is recommended to create a Windows User account, with User name and Password with read

and access permission, before installation.

If you do not know the user yet, you can choose Local system. The Spooler will then run, initially without
access to any printers, as a simple Windows system service. Now, select Control Panel > Administrative
Tools > Services. Right-click the HELIOS Spooler and select Properties. On the Log On tab, switch to This
account and enter the user name and the password (Caution: Should the password of the Spooler user
change or expire one day, the authentication needs to be renewed accordingly in the Services list). If the
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Start service upon installation option is active, the Spooler service will not require a manual start after
installation.

For starting the “interactive” configuration of the Spooler automatically, the file Helios.Spooler.exe from the
installation directory must be invoked with the option “—no service”, for instance, either from the
“Autostart” folder or via Windows task planning. If you have further questions, please contact our ISD
Consulting team.

Select the data directory. Activate the Create network share checkbox to enable the communication with the
PrintClient. If the network share is not created during installation, it must be created manually afterwards.
Since special settings will be required here, we recommend contacting our Consulting team.

Choose the CAD system that you want to link to the HELIOS Spooler, and click Next.

N

F
) HELIOS Spooler Setup =

Ready to install HELIOS Spooler TS ==

Click Instal to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back ][ Install ] [ Cancel

You can now begin with the installation.

-
) HELIOS Spooler Setup = s

Completed the HELIOS Spooler Setup
Wizard

Click the Finish button to exit the Setup Wizard.

Back Cancel

After successful installation the HELIOS Spooler will be located in the program folder.
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2.7 Installing the HiCAD Viewer

The HICAD Viewer enables you to view drawings in HICAD format (*.sza, *.szx) and output these drawings
(in non-scale representation). This viewer is free of charge and may be provided free, without changing the

scope of delivery.

)201

Activate the HELiOS Viewer.

Installation Documents Client Installations
HICAD - Installation Notes | HICAD and HELIOS |
Program support HICAD Viewer |

The installation of the files is only irad if there i <
T i e 0 HELIOS |
HICAD and HELIOS Help | PostScript Printer |

T = I
r‘_ﬁ! HICAD Viewer Setup =] —

Welcome to the HICAD Viewer Setup
Wizard

The Setup Wizard will install HICAD Viewer on your computer,
Click Next to continue or Cancel to exit the Setup Wizard.

Back l Mext I [ Cancel
-
ﬁ HICAD Viewer Setup I
Destination Folder Wa
Please select the installation folder =

Install HICAD Viewer to:

IC:\Program Files\ISD Software und Systeme\HICAD Viewer',
Back |[ mext | [ cancel

Specify the installation directory for the software.
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-
) HICAD Viewer Setup E=HESN

Ready to install HICAD Viewer

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

You can now begin with the installation.

-
5 HICAD Viewer Setup = ET]

Completed the HICAD Viewer Setup
Wizard

Click the Finish button to exit the Setup Wizard.

| Back ‘l Finish I | Cancel |

Click Finish to end the HiCAD Viewer installation. You can now choose more components from the selection
mask.
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2.8 Installing the HELIOS Database Creator

The HELIOS PDM modules (Document management, Part Management, Workflow etc.) are based on a
relational database. Before you put HELIOS into operation, the Microsoft SQL Server database administration
system needs to be installed on the server, a HELIOS database needs to be imported and a ODBC
connection needs to be set up on the clients.

When you set up a HELIOS database for the first time, the HELIOS Database Creator needs to be installed
and executed on the database server first. The database and table structures will then be created, and filled
with data records of the HELIOS standard database.

O All information about the correct procedure for the execution of the HELi0S Database Creator, as well as
the previous and subsequent steps required for the setting up of a database server can he found in the user
guide for the installation of the Microsoft SQL Server. You can find this document in the 1SD Wiki at Product
Know-how > Documentation > HELi0S.

To install the HELIOS Database Creator, click the corresponding button in the selection mask. The start
mask of the setup wizard will be displayed.

This component may only be installed on the License Sarver! HICAD Spooler

SafeNet License-Server I HELIOS SmartSearch Server |
HELIOS Database Creator ] HELIOS Vault Server |
FIG-FGA Converter | HELIOS Application Server |
b
rﬁ HELIOS Database Creator Setup Euﬂ‘

Welcome to the HELIOS Database
Creator Setup Wizard

The Setup Wizard will install HELIOS Database Creator on
your computer. Click Mext to continue or Cancel to exit the
Setup Wizard.

Back [ Next J [ Cancel

Click Next to start the installation.
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-
) HELIOS Database Creator Setup = |

Destination Folder To o =
==

Please select the installation folder

Install HELIOS Database Creator to:

IC:‘Program Files\ISD Software und Systeme\HELIOS Database Creator),

Change...

ack |[ mext | [ cancel

Specify an installation directory for the HELIOS Database Creator, and click Next.

-
) HELIOS Database Creator Setup =15

Ready to install HELiOS Database Creator 'S0 I

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Click Install to start the installation.

-
75 HELIOS Database Creator Setup =15

Completed the HELIOS Database Creator
Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back |l Finish I | Cancel

Click Finish to complete the installation of the HELIOS Database Creator. If desired, you can now install
further components via the selection mask.
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O Extensive information on the installation of the SQL Servers, the operation of the HELi0S Database Creator
tool and the settting up of the ODBC connection on the clients can be found in the Wiki at Product Know-how >
Documentation > HELi0S.

2.9 Installing the HELIOS SmartSearch Server

The Smart Search in HELIOS allows finding documents, assemblies, folders and projects on the basis of an
overarching (including all object types) metadata and full text search.

For using Smart Search, an index server of HELIOS Smart Search Server must be installed. The only
requirement for the installation is JavaRuntime Environment. If Java Runtime Environment is not available
on the server yet, it must be installed, too.

To install the HELIOS Smart Search Server, start Windows. If Windows is already open, exit all running
programs. Insert the DVD-ROM into the DVD-ROM drive of your computer. The screen with the software
components opens subsequently. The selection screen stays open, for that the necessary components can
be installed successively.

If the Autostart Function is shut down in the operating system, it is necessary to run the file setup.exe from
the main directory of the DVD-ROM, as only then it is ensured that the version identifies the operating
system properly and the appropriate version will be installed.

HICAD Viewer Help \ Server Installations
HELIOS Desktop Help | HELIOS Internet Server I
Administrator Tools HELIOS Spooler ‘
This component may only b2 installed on the Licens Senver! HICAD Spooler I
SafeNetLicense-Server : I HELIOS SmartSearch Server I
HELIOS Database Creator | HELIOS VaultServer |
FIG-FGA Converter | * HELiOS Application Server I

N

Activate HELIOS SmartSearch Server.

In case if there is no Java Runtime Environment available yet, it must be installed first.

ﬁ HELIOS SmartSearch Server Setup =|FE] ¥ |

Welcome to the HELIOS SmartSearch
Server Setup Wizard

TSR =

The Setup Wizard will install HELIOS SmartSearch Server on
your computer. Click Next to continue or Cancel to exit the
Setup Wizard.

Back [ Mext ] [ Cancel

Click Next.
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) HELIOS SmartSearch Server Setup L= x|

Destination Folder
Please select the installation folder

Install HELIOS SmartSearch Server to:

IC:\Program Files\ISD Software und Systeme'\HELIOSSmartSearch,

([ Back J[_newt ] [ concel |

\ Wy

Select an installation directory of the HELIOS SmartSearch server and click Next.

) HELIOS SmartSearch Server Setup el

Ready to install HELIOS SmartSearch Server "5 1 5C =5

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

i
i
|
i
i
|

Back || wstl | [ cencel |

You can start the installation now.

rﬁl HELIOS SmartSearch Server Setup L=l |

Completed the HELIOS SmartSearch
Server Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back |l Finish ] | Cancel

Click Finish to end the installation.
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2.10 Trial Edition (Demo Version)

The Trial Edition (Demo Version) has a changed data format, which allows a reading of data out of the
Standard Edition, but not a writing of data back to it (i.e. in a Standard Edition the data format of special
versions is not readable!). For printouts, plot stamps will always be output.

(O The license is free and valid for 60 days from the date of installation. Its transfer to other computers after
its activation is not possible.

If the Autostart function has been switched off in the operating system, you must run the setup.exe file in
the root directory of the DVD for installation. Only in this way will be be ensured that the version of the
operating system will be correctly recognized and that the correct HICAD version will be installed.

N
I 15D Installation 2017 [

Standard Edition
Trial Edition |

Education Edition ‘

© 1985 - 2017 ISD Group. Al rights reserved.

In the start mask of the Installation Wizard, click Trial Edition.

Before using HICAD/HELIOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have
been installed on the computer; these packages will be installed as part of the HiICAD installation if required.

r T N
1) HICAD 2017 EN Setup [E=REE

‘5 Welcome to the HiICAD 2017 EN Setup
HIGAD v
2017

The Setup Wizard will install HICAD 2017 EN on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.

[ Next ] [ Cancel

On the Welcome... window, click Next to start the installation.
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r
ﬁ HiCAD 2017 EN Setup = || —

Activation
Activation data for Education Edition

Please enter your activation data. Please note that the activation period is limited for this
wversion and thatit is saved in a data format that differs from that of the full version,
Please make sure that your entries are correct;

EID

Back |[ Next | [ Cancel

Enter the activation data for product activation and click Next.

To obtain the activation data, please fill in the form on our website at isdgroup.com > Products > Free
demo version.

-
) HICAD 2017 EN Setup =ne

Destination Folder

I B g 03 I I ‘. .
Please select the installation folder il = s =

Install HICAD 2017 EN to:

IC:\,HiCAD\

Back ][ Mext ] [ Cancel
Select an installation directory.
("8 HicAD 2017 EN Setup = )
Ready to install HICAD 2017 EN TS

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back ]E Install 1 [ Cancel

Click Install.
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;
— oy

0 Alllocal licanses have been successfully activated.

Click OK to complete the installation.

2.11 Education Edition (Student Version)

The Education Edition (Student Version) is a fully functional standard version. The license is free and valid
for 1 year (365 days). It can be activated and deactivated with the ISD License Manager which will be
available after installation (see Chapter 6.3).

The drawings (.-SZA) and parts (.KRA) created with Education Edition can not be loaded with the Standard
Edition. In case if a file (.SZA or .KRA) created with the Education edition is opened with a Standard Edition,
an appropriate message will be sent. The title bar of the HiICAD interface will show the text HICAD Education
Edition: Not for commercial purposes.

If the Autostart function has been switched off in the operating system, you must run the setup.exe file in
the root directory of the DVD for installation. Only in this way will be ensured that the version of the operating
system will be correctly recognized and that the correct HICAD version will be installed.

5
™ 15D Installation 2017 )

—
=
N
-

Standard Edition |
Trial Edition |
Education Edition |

© 1985 - 2017 ISD Group. Al rights reserved

In the start mask of the Installation Wizard, click Education Edition.

Before using HICAD/HELIOS, Microsoft .NET Framework and the Visual C++ Runtime Libraries must have
been installed on the computer; these packages will be installed as part of the HiICAD installation if required.
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-
) HiCAD 2017 EN Setup e

‘5 Welcome to the HICAD 2017 EN Setup
HIGAD v
2017

The Setup Wizard will install HICAD 2017 EN on your
computer, Click Next to continue or Cancel to exit the Setup
Wizard.

On the Welcome... window, click Next to start the installation.

-
) HICAD 2017 EN Setup =ne

Activation
Activation data for Education Edition

Enter your activation data. Please note that this version can only be activated for a limited
period of time.

Please make sure that your entries are correct; if the activation fails during installation, it
needs to be performed manually after installation.

EID

Back ][ Mext ] [ Cancel

Enter the activation data for product activation and click Next.

To obtain the activation data, please fill in the form on our website at isdgroup.com > Products > Student
version and upload your student identity card or your matriculation certificate.

-
5 HIiCAD 2017 EN Setup =hec

Destination Folder
Please select the installation folder

Install HICAD 2017 EN to:

IC:\,HiCAD‘\

Back ]I Mext I [ Cancel
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Select an installation directory.

-
ﬁ HICAD 2017 EN Setup = —

Ready to install HICAD 2017 EN

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back || Install ] [ cancel

Click Install.

Ino ot |

|o Alllocallicansas have been successfully activated.

)

Click OK to complete the installation.
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3 Procedure for Silent Installations

The silent installation can, for example, be configured for HICAD, for HELIOS Standalone or for the HICAD
Spooler. The procedure is always the same.

3.1 Installation Settings
To configure the installation options, start the installation setup.exe as usual and make the required settings.

In the last dialogue of the installation, click on Extended Settings.

-
5] HiCAD 2017 EN Setup

Ready to install HICAD 2017 EN

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Extended settings

Back Install ] [ Cancel

I

Here you can configure in particular the settings for the User Configuration and the Catalogs in such a way
that user interactions will no longer be required.
»  Parameter configuration via CSV file,

»  Execute CatalogueMaker/CatalogueUpdate: Deactivate Interactive button.

Configuration database

Parameter configuration

i ™
15 Extended settings E@Iﬂ
| HELIOS Interfaces I LogiKal Interface | General
User Configuration | Catalogue | HELIOS

CA\ProgramData\ISD Software und Systeme\HICAD 20:@
Install database

@ Default templates -

©) Own templates Madule
@ Mechanical Engineering
() Steel/Metal Engineering

() Plant Engineering

[C] Attribute configuration acc. to DSTV
HICAD / HELIOS Default Sclution

Font
@ HiCAD

) Arial

[C] Management + BIM

Mavice configuration
| r

Save Cancel
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r ~
1@ Extended settings =RAC X
HELIOS Interfaces | LogiKal Interface | General
User Configuration | Catalogue | HELIOS
Catalogue directory k:'\.HiCAD\Kataloge E|

Copy catalogues to default directory

Execute CatalogueMaker DIN IS0 A
[C] nteractive

[[] Execute Catalogue Update  Previous version | 0
Interactive
Overwrite write protected files
Retain own settings
Delete backup copies

Show log

Save | Cancel |

Clicking Save creates a setup.ini file containing the desired settings. This file will be loaded automatically if it
is located in the same directory as the Windows Installer package HiCAD.msi. Alternatively you can specify a
file via the command line:

setup.exe SETTINGS="<Ini-Datei>" /I*v "<Log-Datei>"
or
msiexec /i HiCAD.msi SETTINGS="<Ini-Datei>" /I*v "<Log-Datei>"

In this case the starting will not be “silent”, i.e. the installation dialogues will appear, but with the default
values of the .ini file.

The option /I*v "<Log-Datei>" creates a log file of the installation which can be used for the diagnosis of
installation problems.

3.1.1 Redistributables

Before distributing the installation you need to install the required redistributables on the target systems in
order to circumvent the Microsoft-EULAs.

Examples:
veredist.exe /passive
dotNetFx40_Full_x86_x64.exe /passive

The respective command line options of the individual Redistributable Installer can be called via the
command line option /?.

If required, the .msu files of the Windows Installer 4.5 can be installed with the Windows Package Manager
pkgmgr.exe (http://support.microsoft.com/kb/934307/de).

The packages can be installed with /passive /norestart. Otherwise, a reboot would be initiated automatically.
If a package requires a reboot, the return value is 3010; otherwise it is O or an error code.

© You need to install the redistributables that are located on the DVD at Program32 or Program64 (except
for the setup.exe and the language-specific folders such as de-de).

The situation for HELIOS is slightly different. Here, the installation packages can be found in the folder
Helios\heldsk64\ (for a HELiOS Desktop Standalone installation) or Helios\M-Versions\20?7\ , with 7? standing for
the concrete year date of the HiCAD Version to be matched with an updated HELiOS.
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The utilisation of the msi package or the setup.exe, respectively, differs insofar as the setup.exe will issue an
interactive message if a requirement (redistributable) is missing, while the msi package will cancel the process
with an error code. The latter might be more suitable for a deployment within the scope of a software
distribution programme.

3.1.2 Starting the Installation in the Silent Mode

The installation can only be set to the silent mode via the command line:
setup.exe SETTINGS="<Ini-Datei>" /passive /I*v "<Log-Datei>"

or

msiexec.exe /i HICAD.msi /gb!- /[SETTINGS="<Ini-Datei>" /I*v "<Log-Datei>"

As neither dialogues nor error messages are displayed, /I*v "<Log-Datei>" creates a log file of the installation
which can be used for the diagnosis of installation problems.

Information on further command line options can be obtained via the command line, by means of the
command msiexec /? , and via the Internet at

http://technet.microsoft.com/de-de/library/ cc759262%28WS.10%29.aspx#BKMK_SetU|
http://msdn.microsoft.com/en-us/library/windows/desktop/ aa372024 % 28v=vs.85%29.aspx

3.1.3 Example of a Batch Installation incl. Redistributables and Log
@set SOURCE=\\entw042\Setups\HICAD 2000

"%SOURCE%\vcredist_x86_10.0.40219\vcredist_x86.exe" /passive /norestart
@if errorlevel 1 echo Fehler bei Visual C++ Runtime Installation && goto error
"%SOURCE %\DotNetFX40\dotNetFx40_Full_x86_x64.exe" /passive /norestart

@if errorlevel 1 echo Fehler bei .NET Installation && goto error

msiexec.exe /gb!- /i "%SOURCE%\de-de\HiCAD.msi" /I*v
"%SOURCE %\logs\% COMPUTERNAME%_HiCADInstallLog.txt" SETTINGS="%SOURCE %\Config\setup.ini"

@if errorlevel 1 echo Fehler bei HiICAD Installation && goto error
@exit

-error
@echo Installationsfehler %errorlevel%
@net helpmsg %errorlevel %

@pause

58


http://technet.microsoft.com/de-de/library/%20cc759262%28WS.10%29.aspx#BKMK_SetUI
http://msdn.microsoft.com/en-us/library/windows/desktop/%20aa372024%28v=vs.85%29.aspx

Configuration

4 Configuration

4.1 Configuration Management

As of HICAD 2012 (Version 1700), HiCAD enables a central configuration management with the
Configuration Editor. This tool allows the creation of customer-specific configurations for a wide range of
tasks, such as dimensioning, annotation, workshop drawing creation, fitting of vertical ladders etc. Once
adjusted to company-specific requirements, these configurations can directly be used in HiICAD, without
having to specify any further settings. The aim of our further developments is a gradual transfer of the
previously used system files with their adjustable parameter settings into the Configuration Editor, thus
enabling a central and safe configuration management.

This transfer has already been realised for the following files:
» ALGPAR.DAT (as of 1800.0)

» BEMPAR.DAT (as of 1800.0)

» DIMENSIONING_SETTINGS.XML (as of 1800.0)
» KRPGEN.DAT (as of 1801.0)

» MASPAR.DAT (ab 1801.0)

» FITTABLE_SETTINGS.XML (as of 1801.0)
» STBEMPAR.DAT (as of 1801.0)

»  TXTANSI.DAT (as of 1801.0)

» STABMPAR.DAT (as of 1802.0)

» AUBMS3PAR.DAT (as of 1802.0)

» ALG3DPAR.DAT (as of 1901.0)

» FEATURE.DAT (as of 1901.0)

» SCHRIF.DAT (as of 1901.0)

» TXTFONT.DAT (as of 1901.0)

» LINPAR.DAT (as of 1901.0)

» SSWRITESTEP.DAT (as of 1901.0)

» PASSTAB.DAT (as of 2000)

»  ANSGEN.DAT (as of 2100)

» PARAMASS.DAT (as of 2101)

»  SSTINI3D.DAT (as of 2102)

»  SSTINI.DAT (as of 2102)

» STB_PARAMETER.DAT (as of 2102)

» GRAPAR.DAT (as of 2201)
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The settings from these files have been integrated into the Configuration Management. In the Online Help
for the Configuration Management you will find the document Schluesselnamen.pdf, which shows you
where you can retrieve the entries from the DAT files in the Configuration Editor.

In addition, the Online Help provides a description of various scenarios for the utilisation of the tool. An
extensive description of the Configuration Management (Performance — Functions — Scenarios) is provided
in the document ISD-Configuration.pdf. You can find this document

» in the ISD Wiki at Product Know-how > Whitepaper

» in the Docu\hicad sub-directory of your HiCAD installation as well as

» on the start page of the Online Help at www.help.isdgroup.com

4.1.1 The Configuration Management for updates

When performing an update from HICAD 2015 or HICAD 2016, your settings from the existing configuration
file HICAD.CFGDB of your previous HIiCAD version will be transferred to the Configuration Management of
HICAD 2017, namely into the Administrator profile.

When the update is performed, only the values predefined by the ISD, i.e. the “factory settings”, will be
changed. All other (administrator or user) settings will be preserved.

If you use a central configuration database on a server, it will be automatically detected by the update
program by means of the aforementioned Registry entry, and will be updated. For an update of several
workstations, one single update will be sufficient; a multiple update will, however, not do any harm either (as
an already updated setting will not be updated again).

When HiCAD is started, the configuration database will be checked.

If HICAD is started with an outdated configuration base, a corresponding message will be displayed. In this
case, please perform an update of the configuration database in order to avoid error messages or
unexpected behaviour.

If HICAD is started with the database of a newer Major Release, a corresponding message will be displayed.
In this case, please use a compatible database to avoid error messages or unexpected behaviour.

4.1.2 The Configuration Management for new installations

If you perform a (new) installation of HICAD 2017, the settings predefined by the ISD will be initially used in
the Administrator profile of the Configuration Management. If you want to transfer your individual settings in
the file HICAD.CFGDB from HiCAD 2015 or HiCAD 2016 to the Configuration Management of HICAD 2017,
use the program CfgDbTool.exe in the HICAD EXE sub-directory for this.

Furthermore, you are enabled to transfer settings from old DAT and XML files which are now managed in
the Configuration Editor, to the configuration database of HICAD 2016.
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» Start the CfgDbTool.exe from the HICAD / exe sub-directory.

[74 CfgDbTool =NECH X

Update | Migrate

Installed database  C:\ProgramData\ISD Sefware und Systeme\HICAD 200 T\HICAl E|

Update source CAHICAD\Configuration\HICAD.cfgdb E|

Update target C:\ProgramDatatISD Software und Systeme\HICAD 201ThHICA E|

Use the Update tab of the CfgDBTool you tab to transfer the settings of your previous configuration file
(.CFDB) to the configuration file.

Installed database The configuration database to be updated, i.e. (the configuration database of
your previous HICAD version 2015/2016).
Update source The configuration database of the new version; the configuration database with

the current ISD settings can be found in the folder: [HICAD installation
directory]\Configuration.

Update target The result of the update. If you enter the same file here as in the Installed
database, a backup of the previous configuration database will be created.
You cannot enter the same database here that you entered in the Update
source field.

»  Select the directories.

» Click the Update button to start the process.

Use the Migrate tab to transfer your individual settings from old DAT and XML files which are now managed
in the Configuration Editor, to the configuration database of HICAD 2017.

The setting files with their adjustments need to be copied to the HiICAD SYS subdirectory of the new HIiCAD
version for this purpose.
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Start the CfgDbTool.exe from the HiCAD / exe sub-directory and activate the Migrate tab.

[, CfgDbTool oo B
Migrate

Base folder CAHICAD E]

Target database  C:\ProgramData\ISD Software und Systerne\HICAD 2017\HICAD E]

Pararneter files must be available in sub folders with the same names like in a
HICAD installation (e.g. sys folder) and under their original names.

HiCAD base folder Here you enter the directory where your old DAT and XML files etc. are located.
Please make sure that the old files have the same name and are located in the
same directory structure as in a HiICAD standard installation.

Target database Here you specify the database to which the data are to be transferred.

» Select the directories.

» Click the Migrate button to start the process.
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4.2  Parameter Configuration

Important note on updates!

When you run the tool Computer Parameter Configurator (HICAD exe\ParKonfigComp.exe) — either during
the installation/update (Extended Settings > User Configuration tab) or later — the following message will be
displayed:

( ParConfig [_Jﬁ ]

The changes to the configuration will now be applied. Files such as HELIOS masks
or HiCAD drawing frames may be overwritten. Therefore, please check whether
you have made backups of your files beforehand.

Cancel |

If you confirm with OK, various system files in the HICAD sys and szenen directory will be replaced with the
files supplied in the HICAD templates directory which have been designed especially for a working with the
selected module and the activated checkboxes (e.g. ...DSTV or Management + BIM). These files include,
for example

- HICAD masks for the part attributes (*.HDX),

- HELIOS masks for projects, documents and articles (*.MSK),
- Various configuration files (*.HDB) and

- Template files for annotations (*.FTD).

You should therefore always make backups of all files that you have customized before using the
ParKonfigComp.exe tool! If you have any questions, please contact your nearest ISD branch office.

Via Cancel the operation will be terminated without any changes to the configuration.

HICAD provides suitably customised interfaces and configurations for various fields of engineering, e.g. for
Mechanical Engineering, Steel Engineering, Metal Engineering or Plant Engineering. You can select these
options during the installation of HICAD.

To change the parameter configuration subsequently, start the programs
» _exe/ParKonfigComp.exe for the workstation configuration, and

» _.exe/ParKonfigUser.exe for the user configuration.

Depending on the selection in the Parameter configuration, the settings stored in the CSV file, too, will be
applied. In a CSV file it is, amongst other things, specified which files (e.g. HICAD part masks or template
masks for annotations) are to be copied to the sys directory. When performing an Update, various system
files in the HICAD sys directory will be replaced with the files supplied in the HiCAD templates directory
which have been designed especially for a working with the selected module and the activated checkboxes
(e.g. ...DSTV or Management + BIM). The standard CSV files are located in the templates directory of the
HICAD installation. CSV files are configuration templates that you can create and edit with Microsoft Excel
(please see Online Help).
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HICAD Parameter configuration - Work station settings

% Default termplate

Module Font
* Mechanical Engineering * HiCAD
" Anial

" Steel/Metal Engineering

" Plant Enginesring

[~ Attribute configuration according to DSTY ™ Management + BIM
¥ HiCAD /HELIOS Default Salution

¥ Mavice configuration

" User-defined template

<ISD defaul> =l

Cancel |

In the dialogue window you have the following setting options:

» Module
Here you choose the required filed of engineering. The common HiCAD parameters are then configured
for this area.

» Management + BIM
Provides the BIM-PDM configuration with typical civil engineering attributes, masks and title blocks.

» Font
Specifies the text font default setting, e.g. for dimensioning, title blocks, view labelling, annotation etc.

»  Attribute configuration according to DSTV
If you want the HICAD attribute masks for parts and drawings to obtain the DSTV-relevant attributes,
please activate the appropriate checkbox. The files BRW_3DTEIL.HDX and BRW_SZENE.HDX in the
HIiCAD SYS directory will be preset for DSTV BOM configuration.

» HiCAD/HELIOS Default Solution
Provides you with a preconfigured database solution for a safe and convenient management of product
data. If you want to use it, activate the checkbox.

»  Novice Configuration
If you want HIiCAD to be preset so that the automatic procedures of the novice configuration apply,
activate this checkbox.

» Management + BIM (Steel Engineering Drawing Management)
Provides the BIM-PDM configuration with the required civil engineering attributes.

»  User-defined template
Activate this option if you want to use your own configurations. Then select the relevant configuration
file.

C) Important:

When performing an update, only activate the copying of default templates if no user-specific, customized
masks and Bills of Materials are used!
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5 Important Notes on Updates

Before making an update from HICAD 2015 or 2016 to HiCAD 2017 you need to deactivate all licenses
(Server licenses or local licenses). The procedures for Server licenses and local licenses are different.

Backups of the following files must be made, for cases in which an unexpected interruption of the update
occurs: Catalogues, HICAD.cfgdb (Configuration Database) and HELIOS Database (only required if you
actually use a HELIOS Database).

You can conveniently download the current HiCAD version in the Download Area in the ISD Wiki. On the
corresponding DVD you will find, besides the HICAD installation, further utilities and the HELIOS installation.
Please note that the HELIOS installation is the last available HELIOS patch containing the same database
subversion as the HELIOS version that was originally released with the corresponding Major Release.

5.1  Update Server License

For a Server license the License Server software and the License Management tools may require an update.
Furthermore, you need to deactivate the licenses for Versions 2015 or 2016 first, and then activate those for
Version 2017.

You can start with the installation of HICAD Version 2017 before or after activation of the new licenses; a
starting of HiICAD is, however, only possible after activation of the new licenses.

The current Version of the SafeNet License Server, Sentinel RMS License Manager 8.6.2, can be found on
the installation DVD of HICAD 2017. If you have an older version, you need to uninstall this version with the
help of the Windows Control Panel. First, uninstall the Sentinel RMS License Manager there and (if there
are any) the AdminToolsServer.

You can then install the new version of the License Server from the HICAD 2017 Installation DVD.

Click the SafeNet License Server button. The installation guide can be found at Chapter Fehler!
Verweisquelle konnte nicht gefunden werden..

Administrator Tools HELIOS Spooler y
This component may only b2 installed on the Licenss Sagyer! HICAD Spooler l
SafeNet License-Server l HELIOS SmartSearch Server |

HELIOS Database Creator l ~ HELIOS Vault Server ’
FIG-FGA Converter ’ HELIOS Application Server I

Before you can use the new licenses of HiICAD Version 2017, you need to deactivate the old licenses for
Version 2015 or 2016 with the help of the License Manager. This tool is located in the Windows start menu
at All programs > ISD Software und Systeme > Administration.

After starting the ISD License Managers the License Activator tab will be active. Normally, the EID
(Entitlement ID) field is still filled in and the fields E-mail and Password are still empty. The activated
modules of Version 2015/2016 are highlighted (blue). Select the Deactivate button to revoke the activation
of these modules (see Chapter Fehler! Verweisquelle konnte nicht gefunden werden. ).

After confirming the deactivation of your old licenses, the ISD will send you an E-mail with one or several
EIDs. These are required for the activation of the new licenses. The EID-code and the Password remain
unchanged and can be used for the login and for the license activation again.

Follow the instructions given in the E-mail and start the ISD License Manager, which you can find in the
Windows start menu at ISD Software und Systeme > Administration (C:\Program Files (x86)\ISD Software
und Systeme\AdminToolsServer\exe) after installing HICAD 2017.

On the License Activator tab, enter the Entitlement ID, your E-mail address and your Password and click
Login. After connecting to the ISD License Server, all your purchased licenses will be shown. Activate the
licenses with a click on the same-named button (see Chapter Fehler! Verweisquelle konnte nicht gefunden
werden.).
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After successful activation you can start HICAD.

5.2 Update Local Licenses

Before installing HICAD 2017 you need to deactivate the local licenses for HICAD 2015 or 2016 on your
workstation. After installing HICAD 2017 you need to activate the new licenses.

To deactivate the old licenses you use the ISD License Manager which is located in the Windows start menu
at ISD Software und Systeme > Administration (C:\Program Files (x86)\ISD Soft-ware und
Systeme\AdminToolsServer\exe).

On the License Activator tab, click the Deactivate button to revoke the activation of the modules, i.e. to
deactivate them. After successful deactivation, a corresponding message will be displayed.

After confirming the deactivation of your old licenses, the ISD will send you an E-mail with one or several
EIDs. These are required for the activation of the new licenses after installing the new HICAD 2017 version.
The EID-code and the Password remain unchanged and can be used for the login and for the license
activation with the ISD License Manager 4.0 again.

After installing HiCAD, follow the instructions given in the E-mail and start the ISD License Manager, which
you can find in the Windows start menu at ISD Software und Systeme > Administration (C:\Program Files
(x86M\ISD Software und Systeme\AdminToolsServer\exe).

On the License Activator tab, enter the Entitlement ID, your E-mail address (the address to which the E-
mails of the Activation@isdgroup.de were sent) and your Password and click Login.

After connecting to the ISD License Server, all your purchased licenses will be shown. Use the checkboxes
to select the modules that you wish to activate and confirm your selection with a click on the Activate button.
The selected modules will then be activated on your workstation. You can deactivate them again at any time
to enable their use on a different workstation (see Chapter Fehler! Verweisquelle konnte nicht gefunden
werden.).

After successful activation you can start HiCAD.
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5.3 Update of HiCAD

The ISD recommends performing an Update Installation when switching from HICAD 2015 or 2016 to
HICAD 2017 or for the installing of Service Packs and Patches.

Important note on updates!

When you run the tool Computer Parameter Configurator (HICAD exe\ParKonfigComp.exe) — either during
the installation/update (Extended Settings > User Configuration tab) or later — various system files in the
HICAD sys directory will be replaced with the files supplied in the HICAD templates directory which have
been designed especially for a working with the selected module and the activated checkboxes (e.g. ...DSTV
or Management + BIM). These files include, for example

- HICAD masks for the part attributes (*.HDX),

- HELIOS masks for projects, documents and articles (*.MSK),
- Various configuration files (*.HDB) and

- Template files for annotations (*.FTD).

You should therefore always make backups of all files that you have customized before using the
ParKonfigComp.exe tool! If you have any questions, please contact your nearest ISD branch office.

5.3.1 Backups before installation

Before starting the HICAD Update Installation, create backups of the following files:
» Catalogues
» HiCAD.cfgdb (Configuration Database)

» HELIOS Database (only required when you actually work with a HELIOS Database)

These components will be automatically updated during the installation. Nevertheless is a backup of these
components recommended, e.g. for cases in which an unexpected interruption of the update occurs.

Please create an archive folder for the storage of these backups.

5.3.1.1 Backups of catalogues

Search the folder where the catalogues of the old version are located.

» In case of a local installation this is usually the KATALOGE folder in the directory of your HICAD
installation.

» In case of a network installation the catalogues are normally located in a shared network folder, which is
indicated in the Windows Registry at HKEY_LOCAL_MACHINE\SOFTWARE\ISD Software und
Systeme\HICAD\210X.X (or 200X.X) in the CatDir key.

In the Windows Explorer, right-click the folder that contains the catalogues. Select Send to > Compressed
(zipped) folder. Important: Please choose a descriptive name for the zipped folder enabling an easy
recognition of the catalogues, e.g. HICAD_2016_CATALOGUES.ZIP

After its creation, move the file to the archive folder.
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5.3.1.2  Backup of configuration database HiCAD.cfgdb
Before installing the new HiCAD version, copy the old file HICAD.cfgdb to the archive folder.

In the Windows Registry atHKEY_LOCAL_MACHINE\ SOFTWARE\ISD Software und Systeme\HICAD\210X.X
(or 200X.X) in the CfgdbPath key you can see where the file HICAD.cfgdb is located.

5.3.1.3  Backup of HELiOS database

1. Open the SQL Server Management Studio. Select Start > All Programs > Microsoft SQL Server
20XX > SQL Server Management Studio.

Click Connect.
At the left side, right-click bauteil... in the list.
Select Tasks > Back Up.

ok W

Ensure that the backup will be stored in the archive folder. You can then compress the backup file
(.bak) to a ZIP file.

5.3.2 Update Installation of new HiCAD Version

You can conveniently download the current HICAD version in the Download Area in the ISD Wiki. On the
corresponding DVD you will find, besides the HICAD installation, further utilities and the HELIOS installation.
Please note that the HELIOS installation is the last available HELIOS patch containing the same database
subversion as the HELIOS version that was originally released with the corresponding Major Release. The
advantage of this is that you will not need to update the database as well thanks to the simultaneous
installation of HELIOS.

If the Autostart function has been deactivated in the operating system, it is mandatory for the installation of
HICAD to start the setup.exe file from the root directory of the DVD; only in this way it is ensured that the
version will recognize the operating system, and that the matching HiICAD version will be installed.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection
options for software components.

.
¥ HICAD 2017 (x64 2200.0), HELIOS 2017 (x64 2200.0) DB Version 145 [

Installation Documents Client Installations

HICAD - Installation Notes | HICAD and HELIOS |

Program support HICAD Viewer |

‘The installation of the Help Sles it ly requised if there

The mion. ip iles is only raquired if there is no. HELIOS |

HICAD and HELIOS Help | PostScript Printer |

HICAD Viewer Help | Server Installations

HELIOS Desktop Help | HELIOS Internet Server |

A hnwésizator Tooks HELIOS Spooler |

This component may only bs installed on the License Saryer! HiCAD Spooler |

SafeNet License-Server | HELIOS SmartSearch Server |

HELIOS Database Creator | HELIOS Vault Server |

FIG-FGA Converter | HELIOS Application Server |

L
".Tnbeﬁhmxudmeﬁeni.ngSmgui&s)wmmmw. o
(15 TR =3
© 1985 - 2017 ISD Group. All rights reserved

Leave this selection mask open, so that you can select the desired components one after the other.
Click the HIiCAD and HELIOS button to start the installation.
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%) HICAD 2017 EN Setup

= ;
Welcome to the HiCAD 2017 EN Setup
Wizard
2 n ] 7 The Setup Wizard will install HICAD 2017 EN on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.
Back [ Next ] [ Cancel ]
r M
ﬁ HiCAD 2017 EN Information |

Setup Information

Flease note the following importnat information

File and database compatibiliity -
Please read the compatibility information about the
file and database format. This information is either
supplied with the software or can be downloaded from|s
the ISD Homepage.

Conversion of 2-D part file format from FIG to FGR
During conversion to the current HiCAD wversion, the
format of the 2-D part files will be converted from
FIG to FGA.

The conversion of the files that are supplied by
default takes place during installation. Before
conversion, the data will be backed up in their

Back ][ Mext ] [ Cancel

First, important information about data compatibility will be displayed. Please read this information carefully.

If the installation program finds an already installed HICAD Version, this will be indicated in a corresponding

dialogue window:

-
) HICAD 2017 EN Setup =ne

Setup has found an existing version
Please select the type of this installation

Installation of HICAD 2017 EN as

() New Installation

Back ][ Mext ] [ Cancel

Activate the Update Installation option and click Next.
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) HICAD 2017 EN Setup = e G

Destination Folder

Please select the installation folder @

Install HICAD 2017 EN to:

|C:\,HiCAD\

Back ][ Mext ] [ Cancel

Select an installation directory.

) HICAD 2017 EN Setup = 3
Optimisation of user-friendliness
TS0 =

‘fou can help us increase the user-friendiness of our products even further, To

participate or terminate your participation, please activate the corresponding checkbox
shown below

‘Yes, I hereby give my consent for the transmission of data on the
functionalities that I use to the ISD. For further information please read our
Data Protection notes.

[7] Mo, Idonotwant to particpate.

‘fou can terminate your participation at any time by choosing Help > Customer
Feedback, and selecting the corresponding checkbox

Back ][ Mext ] [ Cancel

You can help us increase the user-friendliness of our products even further. To participate or terminate your
participation, please activate the corresponding checkbox.

You can terminate your participation at any time by choosing Help > Customer Feedback, and selecting the
corresponding checkbox.

) HICAD 2017 EN Setup = i e

License Management

License Motes and Settings @

Notes on Hardware Exchange

| »

If you use local HiCAD/HELiOS/HELiCON licenses and
want to exchange any hardware components, modify the
partitioning of, or re-install the operating system,
you need to revoke the existing license on the HiCAD
workstation first, and request, using the new
hardware or modified configuration, a new license
key (further information on the procedure can be
found in the software documentation).

VI

m,

 accept the Notes on License Management;

Back ][ Next ] [ Cancel

Please read the Notes on Hardware exchange carefully. Accept the notes and click Next.
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f 5
) HICAD 2017 EN Setup = X
Ready to install HICAD 2017 EN [ B

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Extended settings

Back ][ Install ] [ Cancel

You can now start with the installation or modify the Extended Settings, e.g. for the user configuration, the
catalogues, or HICAD with HELIOS.

. ~
j@ Extended settings =RE X
| HELICS Interfaces | LogiKal Interface I General
User Configuration | Catalogue | HELIOS

Configuration database ~ C\ProgramData\ISD Software und Systeme\HiCAD ZOfE]
Install database

Parameter configuration @ Default templates 5 -

) Own templates Madule Font
@ Mechanical Engineering @ HICAD
_! Steel/Metal Engineering ) Arial

_) Plant Engineering

[C] Attribute configuration acc. to DSTY [C] Management + BIM
HICAD / HELIOS Default Sclution
Novice configuration

T
H

In the Configuration Database, customer-specific settings for various features such as dimensioning,
annotations, workshop drawing creation or fitting of vertical ladders are stored. When making an update,
customer-specific settings can be applied. In addition, values that have not been modified by the user will
automatically obtain the updated pre-settings.

Depending on the selection in the Parameter configuration, the settings stored in the CSV file, too, will be
applied. In a CSV file it is, amongst other things, specified which files (e.g. HICAD part masks or template
masks for annotations) are to be copied to the sys directory. When performing an Update, various system
files in the HICAD sys directory will be replaced with the files supplied in the HICAD templates directory
which have been designed especially for a working with the selected module and the activated checkboxes
(e.g. ...DSTV or Management + BIM). The standard CSV files are located in the templates directory of the
HiCAD installation. CSV files are configuration templates that you can create and edit with Microsoft Excel
(please see Online Help).

Parameter configuration: No templates is activated by default. You can also change this setting
subsequently, via the programs ..exe/ParKonfigComp.exe (for the workstation) and ..exe/ParKonfigUser.exe
(for the User).
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j% Extended settings l |5 éj
HELIOS Interfaces | Logikal Interface | General
User Configuration | Catalogue | HELIOS
Catalogue directory |C:'\.H ICAD\Kataloge E]

Copy catalogues to default directory

Execute CatalogueMaker DIM IS0 A
[C] Interactive

[ Execute Catalogue Update Previous version |0
Interactive
Overwrite write protected files
Retain own settings
Delete backup copies

Show log

Save Cancel

The execution of the CatalogueMaker serves the purpose of specifying which standard series are to appear
in the standard part catalogues (currently standard series are available for DIN, I1SO, EN, ANSI and JIS); the
selection of standards in the CatalogueMaker only influences the display of standard parts, but not their
availability; the availability is still controlled via license selection in the ISD License Manager.

In case of updates, the existing configuration will be applied, and the CatalogueMaker will not be started
automatically. If you want to add standards to the catalogues, the program can be called via Start > All
Programs > ISD Software und Systeme GmbH > Administration.

F N
j@ Extended settings l =HACY ﬂj

HELIOS Interfaces | LogiKal Interface I General |
User Configuration | Catalogue | HELIOS

System data source HeliosBauteil

User hicad

Password senee

Use Vault Server Address  localhost Port 9000

SmartSearch-Server [0 Activate

Configuration
Use Spocler Server localhost

[C] Use Application Server  Address Port

[ oK ] [ save | | cancel |

In case of a new installation of HELIOS you can specify an arbitrary name for the system data source. In
case of an update, the existing data source will be offered. User and Password will be identical with the
ODBC login.

If you use a Vault Server, activate the Vault Server checkbox. Enter the name of the Server in the Address
input field, and the Server Port of the Vault Server in the Port input field. You already entered both during
the installation of the Vault Server.

If you have not installed the Vault Server yet, you can do this now: Choose HELIOS Options > Database >
General > Vault Server [...1 .
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During an update installation it will be checked whether the existing HELIOS version is newer than the one
on the DVD. If this is the case, the HiICAD installation will only update the non-HELIOS files. The HELIOS files
are those that would be supplied by a standalone installation of the HELIOS Desktop, minus the
hicadcommons contained therein.

If you want to process your print jobs via the ISD Plot Management, you need to install one PrintClient on
each workstation. Activate Use Spooler. In the Server field, enter the network name of the computer on
which the Spooler is installed. The Spooler collects the print jobs and processes them, taking your settings
into account.

Individual settings for the HELIOS surface can be transmitted to additional users and computers. To do so
create a ZIP file in HELIOS via View > Settings > Export. During the installation you can select and import
the surface configurations for the HELIOS desktop under Ul configuration.

. |

ﬁ Extended settings =SHREN X

| User Configuration I Catalogue I HELIOS
HELIOS Interfaces | LogiKal Interface I General

Office

Excel
[C] Outlook 0 32 bit
[C] PowerPaint ©i64 bit
Word

Sonstige
EPLAN

Savel Cancel|

The availability of interfaces with HELIOS depends on the programs that are installed on your computer.
With the exception of the HELIOS interface, you can only use 32Bit versions with HELIOS 32Bit, and 64Bit
versions only with HELIOS 64Bit. For MS Office it is generally possible to use a 32Bit Office with HELIOS
(64Bit). However, for old BOMs an additional, special ODBC connection will be required. In such cases,
please contact our Consulting team.

Multiple selections are also possible. The HELIOS functions will be integrated in the programs that are linked
to HELIOS.

O Please note:

= A compatibility matrix of the CAD systems can be found in the Wiki, at Product Know-how > FAQ >
System & Hardware > HELi0S Desktop.
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ﬁ Extended settings [ =|E éj
User Configuration | Catalogue | HELIOS
HELIOS Interfaces | LogiKal Interface | General
LogiKal directory | CALOGIKAL ()

Save Cancel

If you have installed LogiKal on your computer, you can enter the installation directory here.

j% Extended settings [ = |8 éj
User Configuration | Catalogue | HELIOS |
HELIOS Interfaces | LogiKal Interface | General

Installation directory | C:\HICADY

Update-Installation

[ok] [ save | | cancel |

The Activate license administration tools must be activated for the installation of server licenses.

Click Save to save the Extended Settings to an INI file. If you place the INI file in the installation directory
when installing server licenses, the settings will be applied.

As soon as you exit the Extended Settings dialogue with OK, the installation will be started.

O In HiCAD, at Settings > Further directories you can set the paths for the database of the Configuration
Editor, the Catalogue directory and LogiKal. These paths are located in the Windows Registry at
HKEY_LOCAL_MACHINE\SOFTWARE\ISD Software und Systeme\HiCAD\nnnn.n.
nnnn.n is the HiCAD version number, e.g. 2200.0.

Close the Extended Settings dialogue window with OK and click Install.
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If you have not activated a new license yet, the following message will be displayed:

{5 HICAD 2016 EN-Setup

i'i You require a new license key for the new HiCAD/HELIOS version.
* ) Please contact the ISD at (license_request@isdgroup.com)

If you continue the installation despite an old license,

you cannot start HICAD/HELIOS immediately after. Therefore, only
perform the update if you already have the current licenses, and
copy them to the server after installation if required!

Cancel installation I Continue anyway I

Click Continue anyway to start the installation.

Towards the end of the installation you can specify the procedure for the updating of the catalogue files. If
you select Cancel, the catalogues will not be updated.

Please remember that HICAD will check the version of the utilized version upon HiCAD start. If the catalogue
directories are old there is a risk that HICAD will search for catalogue entries which do not yet exist in the old
catalogues. One example of this is the Textures that were integrated in the catalogue some time ago. If these
are missing in the catalogue, you will have no access to these Textures in HICAD. Use the
CatalogueUpdate.exe program in the HiICAD EXE directory to update the catalogues.

F A
4 Catalogue Update ﬁ

Source | E:\Programmé4\en-usthicad3.cat\kataloge @

Target | C:\HiCADKataloge

Qverwrite write protected files Previous

[T Retain user settings (Sort etc.) 2102.0
When update successful, delete backup copy
Current
Show log file after update
2200.0

[ 7] Start Catalogue Editor after update

Cancel

Specify the desired settings and click Update.

After successful updating, the update information for the replaced files will be shown in a dialogue window.
The old files will be preserved and renamed, e.g. 0.mac > 0.mac.2002.
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| Update_2200.0_14.02.17_114256.og - Editor =

Datei Bearbeiten Format Ansicht 2
START: 14.02.2017, 11:42:56

| >

SOURCE CATALOGUE: E:‘\Programméd)\en-us‘hicad3.cat\kataloge
TARGET CATALOGUE: C:\HiCAD\Kataloge

PREVIOUS VERSION: 2102

SETTINGS :

Replace RO-Files :
Delete Backup Files :
Keep Personal Sertings :
show protocol File :
Start CATEditor :

oROoRR

CONVERT *.FIG -> *.FGA
path for backup and log files: c:\Hicap\kataloge

A2HF1_16. IPT —> NO CHANGED
AZHF1_40.IPT -> NO CHANGED
A2RF1_100.IPT  -> NO CHANGED
-> NO CHANGED
—> NO CHANGED
-> NO CHANGED
—> NO CHANGED
-> NO CHANGED

C:\HicaD\kKataloge\anlagenbau\ANLAGENBAU. IPL

"GF10242_s130R23" IN CATALOGUE "3230010"
F10242_S165" IN CATALOGUE "3230010"

IN CATALOGUE "3230010"

IN CATALOGUE “1010011"
IN CATALOGUE ™ "
IN CATALOGUE
IN CATALOGUE ™
IN CATALOGUE
IN CATALOGUE ™
IN CATALOGUE "
IN CATALOGUE ™
IN CATALOGUE
IN CATALOGUE
IN CATALOGUE
IN CATALOGUE ™
IN CATALOGUE
IN CATALOGUE ™
IN CATALOGUE
ADD TABLE: "ARM2WVSRN" IN CATALOGUE "4100010" -~

<[ i J v

Click Save to save this list to a directory of your choice. Click OK to continue with the installation.

& B
1) HICAD 2017 EN Setup (=N

Completed the HICAD 2017 EN Setup
HIGAD v
2 n ] 7 Click the Finish button to exit the Setup Wizard.

(=]
Q

Click Finish to complete the HICAD installation.

If you have already activated the new Server License before the installation, you can start HICAD now
(Standard Configuration).

If you have a local license you need to activate it first before you can start HiICAD.
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5.4  Data Compatibility HICAD/HELIOS 2017 (Version 220X.x)

Please note that no changes are made to the HiICAD data format and the HELIOS standard database within
major releases. This means that all patches and service packs of a version (e.g. 2200.x, 220X.x) will be
using the same data format, and no HELIOS update will be required.

() When updating from older HiCAD versions to version 220X.x, please note the information given bhelow.
Updates to version 2017 are only possible from version 2016 (version 210X) or 2015 (version 200X).

Update from version HELiOS-Update Changed HiCAD data format
HIiCAD 2016 (Version 210X)

HIiCAD 2015 (Version 200X)

(O Please note:

= If a HELiOS update is necessary, older HiCAD, respectively HELiOS versions have no access to the
database any more. All workplaces need to be converted at the same time.

= |If the HiCAD data format has heen changed, drawings and parts cannot be loaded with the older version
if they were saved with the new version.
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9.9

The

Perform Installation

installation of version 2017 can be carried out by a technician of the ISD or by the customer.

In this context, please note the following recommendations by the ISD:

»

»

»

/8

HIiCAD without HELIOS

= Update of version 2016 or 2015 to version 2017: Can be carried out by experienced users with
sufficient background knowledge.

» Update of version 2014 (or older) to version 2017: An update is not possible. The update
installation from version 2008 (or older) additionally included a data conversion from ANSI to
UNICODE format. Please contact our Consulting team.

HiCAD with HELIOS
= Update of version 2016 or 2015 to version 2017: An installation by the ISD is recommended.

= Update of version 2014 (or older) to version 2016: An update is not possible. The update
installation from version 2008 (or older) additionally included a data conversion from ANSI to
UNICODE format. Please contact our Consulting team.

3rd party CAD with HELIOS
= Update of version 2016 or 2015 to 2017: An installation by the ISD is recommended.



Important Notes on Updates

5.6  New File Format for 2-D Files

Similar to the KRA files in 3-D there are now 2-D figure archives with the filename extension .FGA. This
contain the previous 2-D data (.FIG), the DB attributes (.FIG.DBA2) as well as the attribute container data
(.FIG.ATC) and replaces the former 2-D files. Moreover, the new FGA format allows the displaying of 2-D
files in HICAD Viewer and also contains the 2-D HCM files.

HiCAD 2017 comes with the new 2-D figures archives with the file name extension .FGA. Please use only
this new .FGA format for conversion of existing 2-D .FIG files! For this purpose, use the new
Converter_FIG_To_FGA.exe tool in the HICAD\exe directory.

When updating to HiCAD 2017 all standardly supplied 2-D parts (e.g. drawing frames) in the different
installation directories will be converted from FIG to FGA by default during the installation. The data in the
original state will be saved in a folder (resp. a ZIP archive) in the scene and catalogue directory. The
converted files will be documented in a LOG file.

When creating an interface between HICAD 2017 and HELIOS, you will be prompted to update the
databases after a new installation or an update installation. The search for and management of 2-D parts will
only be possible after conversion of the database and the existing .FIG files with the above mentioned tool.

If you are managing your HIiCAD files with HELIOS a message will appear after an update or a new
installation of HICAD 2017 when you start HICAD 2017 as administrator:

Adjustment of the HELIOS database to the 2-D part format FGA

when you switch the CAD workstations ko HICAD 2017 wou need to convert the Format
e/ of the saved 2-0 parts from FIG to FGA

Two steps are required For the conver sion:

1. Conversion of the database by confirming this dialogue.

2. Conversion of the saved 2-D parts with the "Corverter FIG_To FGA.exe" program,

Further information can be Found in khe Help

Start database update for 2-0 parts?

) ) ()

By clicking Yes you convert the files to the database. This means that the 2-D part name contained in the
data will be changed from *FIG to *.FGA. Moreover, the database now only searches for FGA files.
Therefore, you also have to convert the 2-D parts into FGA files by using the Converter_FIG_To_FGA.exe
program.

If you have installed HICAD 2017 for testing purposes, you will have to click No when the message appears.
Older HiCAD versions (before HiICAD 2017) cannot load FGA files. A database conversion cannot be
undone.

After the conversion the following message appears:

W pcfjustmant of the HELIDS datsbate to the 2D part format FGA  ESE

The database has been successFully adjusted to the 2-D part

! format FGA.

Now start the Converter_FIG_To_FGA.exe program to convert the 2-D parts.
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[T Convert FIG to FGA

Folder to scan: |D:\210X\dev\[nstall\52enen

Filegrup.dat: |C:\H|'CAD\exe\FILEG RUP.DAT

]

(7]

Convert Folder HicadDriveletter *FIG

1 CAHICAD\sys .z 0 ~
2 CAHICAD\szenen ACEFGHLLNQSTUV40
3 CAHICADvnorm B 0
4 CAHICAD\ega D 0
5 CAHICAD\material K 0
& CAHICAD\REFTEILET L ]
7 CAHICAD\REFTEILEZ (M 0
8 CAHICAD\pneu o] 1
9 CAHICAD\plo P 0
10 CAHICAD\makroabw R a
1 CAHICAD\etesym (W 0
12 CAHICAD\temp X # 0
13 CAHICAD\custom Y 0
14 CAHICAD\makro2d 0 0
15 CAHICAD\makro3d |1 0
16 CAHICAD\makrost3d 2 ]
17 CAHICAD\makromod 3 0 »

Create backup (zip) ] Overwrite existing FGA

Scan for *.FIG Convert FIG->FGA
Folder backup and log: |C:\Users\Doku\Documents\ISD Software und Systeme;’ConvertEI_ :l
Folder File *FIG *FIG.DBA2 *FIGATC  *FGA

1 DA210X\devinstall\Szenen DINAO s vy X X
2 DA210Xdevinstall\Szenen DINAQ_TS & & 3 x
31 DA210K\deviInstall\Szenen DINAL W V X X
4 DA210X\delInstalNSzenen DINAL_TS & & Py o
5 D:210X\devinstal\Szenen DIMAZ Py vy X X
§ DA210X\deviInstall\Szenen DINAZ_TS & v K x
7 DA210X\deviInstallSzenen DINA3 4 o X X
§ DA210¥\dewiInstal\Szenen DINA3_TS & & A ~
g DA210X\devinstal\Szenen DINA4H 4 v X X
10 DA210X\deiInstall\Szenen DINA4H_TS & & P x
11 DAZ210X\deviInstall\Szenen DINA4Q 4 4 X X
12 DA210X\dev\Install\Szenen DINA4Q STAHLBAU W W A P
13 DA210X\deviInstall\Szenen DINA4Q TS & & F.e F.e
14 DA210X\deInstall\Szenen LSTRASS0 & x K x

Folder to scan ¥

Enter the path of the folder that should be converted. Via this symbol
you can select the folder in the Windows Explorer.

The folder will only be evaluated if there is an activated checkbox v
behind Folder to scan.

Filegrup.dat v

In order to search the directories in the Filegrup.dat for FIG files the
checkbox behind Filegrup.dat has to be activated.

All directories from the Filegrup.dat that are marked with a tick ¥ will be
considered when searching for FIG files.

¥ Create backup (zip)

If you have activated Create backup a ZIP file with all selected FIG files will
be created.

¥ Overwrite existing FGA

If you have activated the Overwrite existing FGA option, existing FGA files
will be overwritten if he names are identical with the converted files.
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Folder backup and log

Enter the path for the backup and log file.

Scan for *.FIG

By pressing the Scan for *.FIG button you start the search for FIG files in
the selected folders.

Convert FIG -> FGA

Via Convert FIG -> FGA you start the conversion. In the process all *.FIG,
* FIG.DBA2 and *.FIG.ATC will be deleted.

After the conversion the number of converted files will be displayed. Furthermore, the number of defective
converted files will be shown. Further information regarding the error can be found in the LOG file.

5.6.1 Installing the

Convert FIG to FGA

Converted 1 fig files successfully, On 0 fig files an error occured, See log

@ file.

Converter_FIG_To_FGA

Start Windows to install the Converter_FIG_To_FGA. If Windows is already open, close all other applications.

Insert the DVD in the

drive, which automatically starts the installation wizard. Follow the installation

instructions on the screen.

In the installation wizard, click the Standard Edition button, which opens a mask with various selection
options for software components. Please leave this selection mask open, so that you can, one after the

other, install the desired

Select FIG-FGA Converter.

components.
Administrator Tools N | HELIOS Spooler |
. component may only bz installad on the Lm&{ HICAD Spooler |
~ SafeNetLicense-Server l HELIOS SmartSearch Server |
© HELIOSDatabaseCreator |  HELIOS VaultServer |
FIG-FGA Converter ] - HELIOS Application Server |

i T

-
ﬁ FIG2FGA Converter Setup

Welcome to the FIG2FGA Converter
Setup Wizard

Igl' ‘. i~ |
e

The Setup Wizard will install FIG2FGA Conwerter on your
computer, Click Mext to continue or Cancel to exit the Setup
Wizard.

Back [ mext | [ Cancel

81



Important Notes on Updates

-
ﬁ.‘ FIG2FGA Converter Setup =N

Destination Folder To D
L e

Please select the installation folder

Install FIG2FGA Converter to:

IC:‘Program Files\ISD Software und Systeme\FIG2FGA Converter

Back ]I Mext | [ Cancel

Specify the installation directory for the software.

-
ﬁ FIG2FGA Converter Setup =N

Ready to install FIG2FGA Converter

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back ]l Install | ’ Cancel

Click the Install button.
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.
) FIG2FGA Converter Setup E=E~)

Completed the FIG2FGA Converter Setup
Wizard

Click the Finish button to exit the Setup Wizard.

Back |[ Finish ] | Cancel

After a successful installation the Fig2FGA Converter can be found in the program directory and can be
called up in HICAD/HELIOS.
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5.7 Manual Registration of the Multi-CAD AddIns with HeliosCouplings.exe

If you use both HICAD and HELIOS on your system in mixed operation it is not possible (as opposed to the
standalone version of the HELIOS Desktop) to establish an interface between HELIOS and further CAD or

CAE software via an update or modification installation.
To do so you can use the HeliosCouplings.exe tool (inte /exe/ directory of the HICAD installation).

It can be used to activate interfaces with AutoCAD, Inventor, SOLIDWORKS or EPlan.

Office

[C] Excel

[T Qutlack
[C] PowerPaint
[C] Wore

CAD
AutoCAD®

Inventar®
SOLIDWORKS®

QOthers
EPLAN

Tick the checkboxes of the required software and confirm with OK. The interface will then be activated.

The respective software has to be installed in the system.
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5.8  CatalogueMaker

The CatalogueMaker is called automatically by the installation program in case of a new installation.

It specifies which standard series is to be shown in the standard part catalogues (at the moment standard
series are available for DIN, ISO, EN, ANSI and JIS). The selection of the standards in the CatalogueMaker
influences the display of the standard parts only, not their availability. This will still be controlled by the
license selection in the configuration menu.

The existing configuration will be taken over automatically in case of an update; the CatalogueMaker will not
be started automatically. If you want to add standards to the catalogues, the program can be called in the
ISD program group in the start menu via “Administration”.
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5.9 Material Manager

The Material Manager (materialmanager.exe) that enables a taking over of materials from Catalogue Editor to
HELIOS needs to have the same database schema as HELIOS. Therefore the Material Manager will also be
updated.
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5.10 Important Notes on Plant Engineering and Pipeline Planning

If you have used the HICAD modules Plant Engineering or Pipeline Planning with a HiICAD version older
than Version 2016, it is mandatory that you read the information on update procedures given in the Online
Help and also in the PDF document "Plant Engineering/Pipeline Planning — Notes on Updates”.
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5.11 Update Training

ISD now offers a 2-day Update Training for new versions. Further information on training dates can be found
on the attached form or our website: www.isdgroup.com / Support / Training.
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6 Licensing

HICAD/HELIOS can be activated via three license types:
»  Network licenses
»  Standalone licenses (local licenses)

» Commuter licenses

C In the HiCAD directory DOCU you can find an Online Help for the Licence Manager. You start the Help by
calling the LICENSEMANAGER.HTML file in the folder Docu\tools\Licensemanager.

In the ISD Wiki you can find the PDF document Use Case: Checkout Licenses at Product Know-how >
Whitepaper.

6.1 General Information about Licensing

Local (Workstation-Specific) Licensing

If you choose local licensing, the activation will be directly locked to the hardware of the workstation on
which your HiCAD and HELIOS Desktop program is installed.

The ISD will send you an E-mail containing the Entitlement ID for local licenses (standalone). This ID will be
required for the activation and deactivation of the licenses and software modules. Please keep the
Entitlement ID! Without this ID you cannot activate or deactivate any licenses! In case of a defect, no
reconstruction of licenses will be possible without the Entitlement ID! After installing HICAD/HELIOS, you
activate the licenses by means of the License Activator in the ISD License Manager.

Network (Server-Controlled) Licensing

If you choose network (server-controlled) licensing, the license will be directly locked to the hardware of the
server that centrally manages the HiICAD/HELIOS licenses. These licenses can be used on any workstation in
your network that is connected to this server.

The ISD will send you an E-mail containing the Entitlement ID. If you have several network servers, e.g. at
several locations, you will receive one Entitlement ID for each network server. This ID will be required for the
activation and deactivation of the licenses and software modules. Please keep the Entitlement ID! Without
this ID you cannot activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will
be possible without the Entitlement ID! You activate/deactivate the network licenses by means of the
License Activator in the ISD License Manager.

Individual licenses can be checked out from the server and locked to a workstation within or outside the
network (so-called “commuter licenses”). This enables you to continue working at a different location,
without being connected to the license server (unless your HICAD/HELIOS installation requires a connection
to a database server). For this purpose you define a specific period during which you want the license to be
available on a selected workstation. For this period, this license will be blocked on the license server. After
expiry of this period, the license will be made available on the license server again. It is also possible to
manually return this license to the server before expiry of the defined period, if the workstation is connected
to the server. Licenses for one workstation can be checked out for at least one day, with the counting
beginning at 1:00 AM on the day following the checkout date.

If you want to replace/exchange your license server, you need to deactivate all licenses first.

O A static IP address is required for correct operation of the license server!

89


https://wiki.isdgroup.com/display/wpaper/Whitepaper
https://wiki.isdgroup.com/display/wpaper/Whitepaper

Licensing

Practical Examples of Network Licensing

» Let us assume that three licenses have been activated on your server. Monday morning (11.00 am) you
suddenly need to see a customer for design tasks, and you know that you will still be on-site at the
customer’s facility on Tuesday. You therefore check out a license for 24 hours on 11.00 am. This
means that you can use this license until Tuesday night, 11.59 pm, from your mobile workplace. After
expiration of this period, the license is automatically made available again on the server. If you manage
to finish your work on Tuesday at midday, you can go back to your office and return the license to the
server somewhat earlier.

»  Similar situation as the one described above, with the difference that you are not in your office on
Monday, 11.00 am. In such cases you can generate a hardware ID, enabling your colleagues in the
office to check out a license for you. This license is sent to you by E-mail and can then be activated. In
contrast to the previous example, this license is exclusively available to you for a fixed period of time and
cannot be returned to the server before expiration of this period.

OIf you activate a license while the WLAN card is switched on, this license will only be valid and visible when
the WLAN card is switched on. If, however, the license is activated while the WLAN card is switched off, the
license will always be valid, no matter whether the WLAN card is switched on or off.

In the ISD Wiki at Product Know-how > Whitepaper you can find the PDF document Use case: Checkout Licenses.
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6.2  Network Licenses

To be able to use network licenses, a License Server needs to be installed on a computer without
HiCAD/HELIOS.

The license server enforces and manages licensing in multi-user environment. It keeps track of all the
licenses and handles requests from network users who want to run a HiCAD/HELIOS application, granting
authorization to the requesters, or denying requests if all licenses are in use.

The license server must not be installed on the same computer on which an ISD software product (HiCAD,
HELIOS) is installed, as both product share system data concerning the licensing information. Formerly,
such parallel installations of license servers and ISD products were performed in cases where a customer
occasionally wanted to transfer the license to another computer (Remote Commuter License).

O Please note:

= As of HiCAD 2012 (Version 1700), parallel installations of license servers and ISD products (i.e. on the
same computer) are no longer covered by the warranty. The ISD group advises you strongly not to
perform such installations.

= A static IP address is required for a correct operation of the License Server!

}
J - Client 6 Client 1

J

Client 4

iy

Client 3
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6.2.1 Server Installation

The SafeNet License Server is installed from the HiICAD DVD. Start Windows. If Windows is already open,
close all other applications. Insert the DVD in the DVD drive. The installation wizard will be started
automatically. In the installation wizard, click the Standard Edition button, which opens a mask with various
selection options for software components.

O If you want to perform a HiCAD update to Version 2017 and use a license server (i.e. work with network
licenses), you require Version 8.6 of the SafeNet License Server. If you have installed an older version, you need
to uninstall it before re-installing the SafeNet License Server.

. Installation Documents Client Installations
HICAD - Installation Notes | HICAD and HELIOS |
Program support HICAD Viewer |
I"I::‘ztsfcﬂm:ﬂu Help files is only raquirad if there is no HELIOS \
HICAD and HELIOS Help [ PostScript Printer y

HiCAD Viewer Help | Server Tnstallations

HELIOS Desktop Help | HELIOS Internet Server I

s hator Tools HELIOS Spooler |
This component may only b2 installad on the License Saryer! HICAD Spooler |
SafeNet License-Server | HELIOS SmartSearch Server |

HELIOS Database Creator | HELOS VaultServer |
FIG-FGA Converter | HELIOS Application Server |

N

Click the SafeNet License Server button to start the installation.

ﬁ Sentinel RMS5 License Manager 8.6.2 - InstallShield Wizard *

Welcome to the InstallShield Wizard for
Sentinel RMS License Manager 8.6.2

The InstallShield(R) Wizard will install Sentinel RMS License
Manager 8.6.2 on your computer. To continue, dick Mext. Itis
recommended that before continuing the installation, the
previous version(s) are uninstalled, incase they are not used.

Sentinel RMS

WARNIMG: This program is protected by copyright law and
international treaties.

gemalto
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‘E Sentinel RMS License Manager 8.6.2 - InstallShield Wizard
License Agreement

Please read the following license agreement carefully.

License Grant\WWarranty for Software

This License describes limited rights granted by SafeMet, Inc. and/or one of its
subsidiaries (such grantor, “Seller”) to the Buyer.

A.  The term “Software”, as used herein, shall mean a program or programs
consisting of machine readable logical instruction and tables of information
designed as libraries or drivers to work in conjunction with Seller's Sentinel
Keys and/or Software (Products”™). Title to all Software furnished to Buyer

haraundar shall ramain in Sellar Sallar arants tn Biver a non-eyelizive nnn-

(®)1 accept the terms in the license agreement Print

(O)1 do not accept the terms in the license agreement

Installshield

<Back  |[ mNext> || cancel

ﬁ Sentinel RMS License Manager 8.6.2 - InstallShield Wizard

Customer Information

Flease enter your information.

User MName:

Organization:

Install this application for:

(®) Anyone who uses this computer (all users)
() only for me (Doku)

InstalShield

<Back [ Next> || cancel

ﬂ Sentinel RMS License Manager 8.6.2 - InstallShield Wizard
Destination Folder

Click Mext to continue installing to the following folder,
or dick Change to install to a different folder.

D Install Sentinel RMS License Manager 8.56.2 to:

C:\Program Files (x36)\Common Files\SafeNet Sentinel\Sentinel
RMS License Manager),

InstallShield

<Back [ Next> || cancel
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94

# Sentinel RMS License Manager 8.6.2 - InstallShield Wizard

Setup Type
Choose the setup type that best suits your needs.

FPlease select a setup type.

(® Complete
All program features will be installed. (Requires the most disk
space.)

() Custom

Choose which program features you wantinstalled and where they
will be installed. Recommended for advanced users.

InstallShield

= ==

ﬂ Sentinel RMS License Manager 8.6.2 - InstallShield Wizard X

System Firewall Settings Need To Be Modified

The setup program will install the Sentinel RMS License
Manager (license server) on this system. To allow
communication between the RMS License Manager and the
dients running licensed applications, the system firewall
settings need to be modified. The Sentinel RMS License
Manager will be added to the firewal blocking exceptions
list.,

. Keep the checkbox below selected to unblock the
S e nt ne I. R M S firewall. Clearing this chedkdax will let the firewall

block the communication between the dients and the
RMS License Manager.

Unblack the system firewall for the Sentinel RMS
]
License Manager

Tip: For instructions on unblocking the firewall later,
refer to the Sentinel RMS SDK System Administrator's

gemalto” | e

#5 Sentinel RMS License Manager 8.6.2 - InstallShield Wizard

Ready to Install the Program

The wizard is ready to perform selected operation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard,

Installshield

< Back Install Cancel
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15 Sentinel RMS License Manager 86.2 - InstallShield Wizard —

Installing Sentinel RMS License Manager 8.6.2
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs Sentinel RMS License
Manager 8.56.2. This may take several minutes.

Status:

InstallShield

< Back Next >

ﬂ Sentinel RMS License Manager 8.6.2 - InstallShield Wizard

InstallShield Wizard Completed

License Manager 8.6.2. Click Finish to exit the wizard.

The InstalShield Wizard has successfully installed Sentinel RMS

Sentinel RMS

gemalto’

< Back

Cancel

After successful installation you will find the Server (Sentinel RMS License Manager) under Services. From

here you can also start and end the License Server.

% Dienste
Datei  Aktion

ez D Ee2 HE » o0 wp

Ansicht 7

.. Dienste (Lokal)

Den Dienst beenden
Den Dienst anhalten
Den Dienst neu starten

'-.‘.':5 Remotedesktopdienste

£k Remoteprozeduraufruf (RPC)
L’:{; Remoteregistrierung

&k Richtlinie zum Entfemnen d...

'-.C‘-;{;RP(—anatm

151 Sekundare Anmeldung

i€} Sensordatendienst
L’:{;Sensordienst

&1 Sensoruberwachungsdienst

Lk Server
'-.C‘-;{;Sharad PC Account Manager

<

Ermaglicht Be,
Der RPCSS-Di...

Erméglicht Re...
Lésst eine Kon...

Unter Window...
Aktiviert das 5.
Liefert Daten v...

Ein Sensordie...

Uberwacht ver.

Unterstitzt Da...
Manages profi...

Sentinel RMS License Manager MName Beschreibung Status
'-.C‘-;{; Registrierungsdienst fir die ... Fihrt Gerdtere...

Wird ausgefihrt
Wird ausgefithrt

Beschreibung: Py
Sentinel RMS License Manager 3 Routing und RAS Bietet Routing...
“CLRPC-Endpunktzucrdnung Last RPC-Sch..,  Wird ausgefihrt

Wird ausgefihrt

'-.‘.':{;Shellhardwareerkennung Zeigt Meldun...  Wird ausgefihrt
Qilcherheltscenter Der WSCSVC-...  Wird ausgefihrt
L’:{;Sicherheitskonto-Managar Durch den 5ta... Wird ausgefihrt
&k Smartcard Verwaltet den ...
'-.’z{;SmartcarererEtaaufz'ah\un.u Erstellt Softwa... Wird ausgefihrt
'-.‘.':))SNMP-Trap Empfangt Tra...

Starttyp
Manuell
Manuell
Automatisch
Deaktiviert
Manuell
Deaktiviert
Automatisch
Manuell
Manuell

Manuell (Start dur...
Manuell (Start dur...
Manuell (Start dur...

Automatisch
Deaktiviert
Automatisch

Automatisch (Verz...

Automatisch
Deaktiviert

Manuell (Start dur...

Manuell

Anmelden al ™
Lokales Syste
Metzwerkdiel
Metzwerkdier
Lokaler Dien:
Lokales Syste
Lokales Syste
Metzwerkdiel
Netzwerkdiel
Lokales Syste
Lokales Syste
Lokales Syste
Lokaler Dien:

Lokales Syste
Lokales Syste
Lokales Syste
Lokaler Dien:
Lokales Syste
Lokaler Dien:
Lokales Syste
Lokaler Dien: v
>

Erweitert { Standard //
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6.2.2 Client Configuration

To ensure that the HICAD/HELIOS Client finds the correct License Server, an environment variable
LSFORCEHOST should be set on each Client using network licenses. The value HOSTNAME, respectively
the IP address of the License Server is assigned to the variable.

6.3 Licensing via Entitlement ID (License Activator)

Thanks to the enhanced ISD License Manager the communication between the customer and the ISD could
be facilitated significantly.

6.3.1 AutoRequest Licenses

When acquiring a HICAD/HELIOS license, you will obtain one Entitlement ID for local licenses (Standalone)
and another one for network licenses (Network). If you have several network servers, e.g. at different
locations, you will obtain one Entitlement ID for each network server. These numbers will be required for the
activation and deactivation of the licenses and the software modules.

Von: activation@isdgroup.de [mailto:activation@isdgroup.de]

Gesendet: Mittwoch, 18. Januar 2017 09:36

An: Musterfrau, Madine
Betreff: EMS - Entitlement Certificate

Dear musterfrau@isdgroup. de,

Congratulations! An entitlement has been created for you with the following details:

Entitlement Details

EID: 2ddbc643-343e-4ecd-aed4-ThdSheddcfel Start Date: 01/18/2017
Customer: End Date: Never Expires
Contact: musterfrau@isdgroup de

| Associated Products

Product number Quantity Remaining quantity Start Date End Date Status
E102S0L1001 2100.0 2 2 01/18/2017  03/31/2017 Enabled
E107BIB1001 2100.0 2 2 01/18/2017  03/31/2017 Enabled
E130SMB1001 21000 2 2 01/18/2017  03/31/2017 Enabled
MasterLic 2100.0 2 2 01/18/2017  03/31/2017 Enabled

Now, follow the steps given below to activate and manage your entitlement:

1. Start ISD License Manager.

2. Change to tab "License Activator”

3. Log on using the EID, registered E-Mail and Password (ISD download area password).
4. Check licenses to activat.

5. Click on Activate button.

For further assistance, contact us using the following details:
Contact No. - Tel. +49-(0)231-9793-166
Email - hotline@isdgroup.de

Sincerely,
18D Software und Systeme GmbH Team

O Please keep the Entitlement ID! Without this number you cannot activate or deactivate licenses. In case of
a system crash a reconstruction of the licenses cannot take place without the Entitlement 1D!

After installing HICAD/HELIOS you can find the program in the Windows Start menu at ISD Software und
Systeme > Administration. Please note that for the execution of some functions, administrator rights are
required.

The range of functions of the ISD License Manager depends on the activation of the License Administration
Tools option. The information about this setting is entered in the Registry and can also be changed there
subsequently if desired (please contact the Hotline).
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O To activate/deactivate Network Licenses, always start the ISD License Manager via the Windows Start
menu: Select Start > All programs > ISD Software und Systeme GmbH > Administration. To avoid errors when
activating/deactivating licenses, perform an update of the new ISD License Manager and/or the License
Administration Tools beforehand.

Activate the License Activator tab and enter the Entitlement ID, your E-mail address and your Password.
New customers obtain their password from the ISD Hotline. With this password you can also access the
Download Area.

T ——

© 15D License Manager 40 (2201.0254)

Tools

L = E—
Ucense Acoater | o | I

ing Code | sl Remote Autrrsaton Code | HC I |
Authentication
-] 23475 5 Email . Password | **°°*** Logn
oAl  Standalone Network Select Display i lcenses

HICAD Basic Modules

HICAD Extension Modules

HELOS Extension Modules

HELIOS Servermodule

After entering the data, click Login. The ISD License Manager connects to the ISD License Server and the
acquired licenses will be displayed.

This process may take several minutes. You can then activate the licenses.

6.3.2 Activate Licenses

After successful login, the number of available licenses and the number of acquired licenses are indicated
next to each module. Select the modules to be activated and click Activate to start the activation. For Server
Licenses the modules are already pre-selected!

v Sohi
92150 | HICAD I/ A
51/15 | Plant Engineering suite
92/15 Piant Engineering suite plus
92/15 | Plant Engineering suite premium
92/15 | Mechanical Engineering suite
92/15_| Mechanical Engineering suite plus
88715 Mechanical Engineering suite premium
9215 Steel Engineering suite
£7/15_ Steel Engineering suite premium
.

o rter
96/15 HICAD ALUCOBONDS® exchusive Standard
96/15| HICAD ALUCOBONDS exchusive Premium
96/15"| KiCAD ALUCOSONDS hybrid Standard
96/15| HICAD ALUCOBONDS hybrid Premium
HELIOS Basic Modules:

92/150] HELIOS Viewer
3/15 KELIOS Office
93/15| HELIOS Engineer
B4/15(| HELIOS Engineer+

Local D

88/15" | Beams
87/15] Metal Engineering

B9/15 | SteelMetal Engineering

88725 Steel Engineering

88/15/| Steel Engineering, Stairs + Radings
88/15."] Plant Engineering / 3-D Layaut Plsnning
88/15. Pipeline isometry

88/15/ Pipeline Planning

88151 P+ID

89715/ Freeform Surfaces (FFS)

89715 | Report Manager professions!

8915 Plot Manager

88715/ Profile mstalation

88715/ Blement instalation

Symbols / Standards

88/15] 2-D Standard Parts, Complete

827151" 3-D Standard Parts, Complete

15 partsdcad
130/1 9] HiCAD ALUCOBOND®
HELIOS Extension Modules
88/157] HELIOS Spooler Client
HELIOS Servermodule

{] HELIOS Spooler
89/15( HELIOS Vault Server
83/15(| HELIOS Replication Management

| HELIOS Internet Server
89/15(_, HELIOS EPLAN Article Synchroniation
(| HELIOS ERP Connect
91/15("] HELIOS ERP Connect Standard

877157 PLWXML-Export

8715 Iges - Wite
88/15/" Uniagrahics Read
85/15/| SOLIOWORKS Read
85/15/7] Inventor Read

Interfaces

89/15/] ROHR2

89/15/"| WICAM Interface

89715 KIS

88/15/1 DSTV Construction
7| DSTV Production

88/15("] TopsGeo

88/15/"] SONF

88/157] NOX

[ Actvate |

© 1SD License Mansger 40 2201.0254) [
| Tools |
U e = T = A,
Lcense Achvator | Standak 3t I I on | P
Authentication
o 7 3 TAILLG | g g Bcemse.s Password ******* Logout
© Standaione Selectal ] Display trial licenses
1SD Modules
HICAD Basic Modules HICAD Extension Modules CAD Interfaces.
927150 | KICAD classic 88/15/]"] Design Automation 87/15/|_| IFC Interface
2/15 .| Hi Creator 82/15/_| Sheet Metal Professional 84/15 | Repaw T
B9/15 ¥| KICAD stion 5] 83/15/_| DXF/OWG - Read
v
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fter successful activation a message showing you that all licenses have been successfully activated will be
displayed:

Info “

‘o Alllocal licanses have been succassfully activatad.

)

You can then log out and start working with the HICAD/HELIOS modules.
In addition, you will receive an E-mail informing you about the deactivated modules.

For Network Licenses, all modules will always be activated or deactivated (for further information about the
operation of the License Manager, please read the Online Help for the License Manager.

6.3.3 Deactivate Licenses

A deactivation of licenses for modules will be required in the following situations:
»  Exchange of hardware or changing of hard disk partitioning

»  Update of the operating system (e.g. from Windows 7 to Windows 8)
For updates within one version no deactivation will be required.

» Transfer of local modules from one workstation to another
»  Acquisition of further modules, or return of hired licenses

»  Switch from local licenses to network licenses

Please note the following: All workstations with modules having the same Entitlement ID need to be
deactivated completely before a redistribution of the module licenses can take place.

Close all HICAD/HELIOS applications before deactivating local licenses or logging onto the License Manager.

After starting the ISD License Manager the activated modules will be highlighted in a different colour. Click
the Deactivate button to revoke the activation of the modules.

B6911D gy, license.s

HELIOS Extension Modu!
88/19] HELIOS Spooler Clent
HELIOS Servermodule

A selection is not possible, as you need to deactivate all modules, no matter whether local licenses or
network licenses.
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O The deactivation must not be disrupted, e.g. by a logout or the closing of I1SD License Manager!

After successful deactivation the following message will be displayed:

Info Eg'“ .

0 Alllocal licenses have been successfully deactivated.

ok |

6.3.4 Trial Licenses

If you select Display trial licenses after logging in, you will be also shown, besides all trial licenses with a
limited period of validity, all purchasable licenses which are not simultaneously available as trail licenses.

6.3.5 Reconstruction of Licenses

As all licenses are stored on the ISD Server, you can, in case of an interrupted connection or an accidental
deletion of licenses, restore all licenses by logging in with your Entitlement ID. The restoring will only function
if the hardware was not changed (see 4.2.3.3 Deactivate Licenses).

6.3.6 Notes Regarding the Use of Mobile Computers (Laptops)

If you use a computer with WLAN card, Please make sure that the WLAN card is either always switched on,
or always switched off.
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6.3.7 Floating Licenses

If you have acquired a HIiCAD Extension Module with the property Floating-able at runtime, you can
activate/deactivate them during the current HICAD session. The HICAD Selection dialogue window will be
displayed.

Network licenses loaded!
HICAD Basic Modules HICAD Extension Modules CAD Interfaces

[~ HIiCAD Spooler W Design Automation N IFC Interface
[ HICAD classic ¥ Shest Metal Professional |v Repair Tool
™ HIiCAD Creator W Beams+Profiles [¥ DXF/DWG - Read
[v HICAD Solution v Metal Engineering v DRXF/DWEG - Mwiite
[~ HiCAD W /AW Iv Steel/Metal Enginesring Iv ACIS - Read
[ Plant Enginesring suite ¥ Steel Engineering v ACIS -Wwhite
[ Plant Engineering suite plus Iv Steel Engineering, Stairs + Railings Iv Parasolid - Read
[ Plant Enginesring suite premium ¥ Plant Enginesring / 3-D Layout Planning v Parasalid - Write
[ Mechanical Enginesring suite ¥ Pipeline isometry [v CATIAVY - Read
™ Mechanical Engineering suite plus ¥ Pipeline Planning v CATIA VA -\wiite
[ Mechanical Enginesring suite premium ¥ P+ID [v CATIAVS - Read
™ Steel Enginesring suite ¥ Freefom Surfaces [FFS) v CATIAVE -\wiite
™ Steel Enginesring suite premium ¥ Report Manager professional ¥ ProE - Read
[” Steel Enginesring Package ¥ Plot Manager ¥ ProE - write
[ Sheet Metal suite W Profile installation ¥ WDAFS - Read
[” Sheet Metal suite premium ¥ Element installation v WDAFS - \wiite
™ Metal Engineering suite classic v JT- Read
[” Metal Engineering suite Symbols / Standards W JT-'wiite
F Ldeta\ Engineering suite premium ¥ 2-D Mechanical Engneering Standard P. v PLMxML-Amport

A UEfEeuls ¥ 3D Mechanical Engineering Standard F. [ PLMAML Esport
[ HIiCADHELIDS Traines suite 0 9 *| | ¥ lges-Read
[~ HiCAD PEFS Converter incl. Plot Manager W partdcad ¥ lges -wite
[ HICAD Student ¥ HICAD ALUCOBOND® v Unigraphics Read
[~ HiCAD ALUCOBOND® exclusive Standard T [¥ SOLIDWORKS Read
[ HICAD ALLCOBOND® exchusive Premium N ROHR2 W Inventor Read
r H!EAD ALUCOBOND® hyhl!d Slam?lard [ wICAM Irteace
[ HICAD ALUCOBOND® hybrid Premium W KISSsoft
HELIDS Basic Madules # DETY Construction
[~ HELIOS Viewer g ?ST\"GPrnducnnn
I HELIDS Dffice A
[” HELIDS Enginesr b SONE

W NCx

Iv HELIOS Engineer+

Wworkstation Configuration User Configuration

ﬂ ﬂ ﬂ Cancel

If one Extension Module is (de)activated, the Extension Modules that are prerequisites for this module will
also be (de)activated (if they are also floating-able at runtime).
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6.4 Commuter Licenses

Commuter licenses enable you to use network licenses even if the workstation is not connected to the

Server. There are two ways of receiving commuter licenses:
»  Via direct checkout from the License Server

» Via checkout from License Server, without network connection

6.4.1 Direct Checkout from License Server

Start the ISD License Manager 4.0 application (while a connection to the Server still exists). Switch to the

Commuter License tab.

& 150 Licenze Manager 40 22000.126)

19215810232 [ Check Server Hame /P | Seachnetwok |

o L K 12 mR 0232

I Check aul autharsation for temale compber

Load workstaiin confguistion

T ] | Cormton e Vi n e

If you have set the system environment variable LSFORCEHOST, the entered License Server will be
displayed as the preselected server upon start. Use the Search network button to automatically search for

License Servers.

Expand the tree structure of the found Server by a click on the “+”-sign. The result looks as follows:

© 15D License Manager 40 (22000.126)
Tools

| ko g Code | s

| Revoiee Server icerse

15218810232 [ CheckSenmtame /P | [ Seachnowek |
oK 19216810232 Desciion
1001} P M HIAD Saltion

1
D 2980
1005 HICAD Steel Erisenng vereon " Resiicted to kcense cupiy
007 HICAD VA /4% Vession 22807 1m0

1006] Do Auscematies Vassicn, 2230

0

k]
1010] Beams+Profies Version "2293.0° Licerse expiy dete wied Jan 31 235353 2011
1011) Mt Engrssring Version "2233.0
1013] Steel / Metal Engneering Vession®
1014) Stel Erginanting Weesionr 225901
[015] Steel Engineering / Stass Vession®
016] Pioefe Lzomet, 2990

1019 Trarlor Verson 22330
10201 Trarspue and Assambly Techrolog ™
n v

Lo o T T T T e T T T

< m | v
I Check out audhassaon forremole: compuler

Lo esksistion criguashon

Load usai configuation Commuts beanas: Vabdhy in dar: o

Updlate icenses

Select the required licenses by activating the corresponding checkboxes on the left hand side. On the right

hand side, information on the selected license is displayed.
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In the Commuter license: Validity in days field, you enter the number of days that you want the commuter
licenses to remain checked out from the Server. The maximum number of days is 60. By default (or if a “0”
is entered), the value is set to 1.

O For reasons of safety you should check out the licenses only for the required period! If a commuter

license is lost, e.g. hecause of theft or a defect of the client computer, the license on the Server cannot be used
any more before expiry of this date!

© 150 License Manager 40 @mALZ5) =

Tools

Leanen it | e I

192 16810222 Chech Servr Hame /& Seach e
= O 1oz
[

Revase Server cerae

Desesption
HCAD Sohdion

zm0
Rt s beamie ety
100

0

»
Weddsn 11 225359 2014

[Erprpre—————

Load unercorigurssen Commuse eense Vol i d ™

Upde erces

After entering the expiry date for the commuter licenses, click the Update licenses button.

Commuter licenses are checked out from the Server.

15D License Manager 40 (2200.0.126) | =)

SN
(e Acmor | i Coe | I =0

921881022 Cnech Serve Nome /1P Seachnewok
€ 1eie 2R 5
) Mg Vs 9

Hame Descrpion
MelslEngreeing

1
230

100
0

i
Wed Jan3 235353 201

Load wakstaion corbuaton

Lo v coriigasion Comte bosnis Vabdly gt @

All selected licenses are now checked out from the Server and you possess all rights on your computer for
the specified validity period for the commuter licenses. This means that you are enabled to work network-
independent. The checked out licenses are no longer available to the other computers on the net.

You can however also return the commuter licenses before their expiry date. To do this, you need to connect
to the Server, deactivate the checkboxes on the left and click the Update licenses button. All licenses are
now made available on the Server and locked on your computer, i.e. you can now only use HICAD/HELIOS if
there is a connection to the License Server. The licenses made available again can now also be used from
other workstations.
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© 1D License Manager 40 (22000.126) (=

Tools

[Lcroe Achvtor | Sandone e ki | < i cote | st Code [ HCAD oo | LGS Ktpaaton | RevekeSorver Ueeee |

19216810232 | CheckSewerMame /P | [ Seachrewes |

69 15218810232 “ | Name Disciption

LOn)PetManaon Vesen ZRE (| ot
[002] HICAD classic Versien "22930" |7 cene name ]

¥ o [DO3)HICAD Crestor Version "2293.17° Licerse resme cn Setver n

(724 IDO4] HICAD Sckution Wersion 22990 Licenize vtz a0 .
J00E] HCAD Sheet Enpinestng version® | | Masistan "Lisnse check OUT dustion  Aeshicleda feerse svpiy
J007]HICAD VI /8 Vetsien " 22900 Ma b of sinubanecus useis o0
00| Design vicmalion, Version 22981 | | Cemmwer ckens occipied )

2

o) Vesion” i3
[© - Io10] Beams+Pckles Vession "2299.0" Licerse expiy e Wed.Jan 31 235959 2014
f [011] Metal Engineering Version 22980

1073] Steel / Metal Erinseing Vetsion

[014] Steel Engresting Verson 2233

[015] el Engresiig / Star: Verscn'

1016] Fipeline lcmeny Version 22931

1077]P4D Schema Versin 223817

1018] Voo Scasen Sclulion Version “229

1079] Trancisce Version “Z22.0°

020] Tranegion and Asseriby Techrsiog, =

Chck out

Load workstation corguration
Load uest coniguation Comamute losavs: Vaidhy n days 0

6.4.2 Checkout from License Server, Without Network Connection

Commuter licenses can also be drawn from the License Server without an existing network connection.

) Please note that administrator rights are required.

Commuter licenses checked out in this way cannot be returned to the License Server! This means that the
commuter licenses that have been checked out from the Server are only (automatically) made available again
after their expiry date.

Several steps are required for this, by the administrator having a network connection to the License Server,
as well as by the Client having no network connection to the License Server.

The Client starts the ISD License Manager tool, switches to the Remote Locking Code tab and sends the
generated character set to the administrator (via E-mail or over the phone).

© 15D Licens= Manager 40 (22000126 =N
Took:
=
License Actreator | Stardalone Lcerwe Info | Commuter Licerss | Remots Lodang Code 0de | &
Iderkicaon shirg

Wbl g o a1 corgu

Copy b clpboant [ Sommie |
Send 1o e mal ecsive
et e bcanon st 10 E ad osions

£ sk skess

SO

The administrator starts the ISD License Manager and switches to the Commuter License tab. The License
Server is selected, and the required licenses (modules) are activated in the left window. To checkout a
remote commuter license the administrator now needs to activate the Check out authorisation for remote
computer checkbox. Administrator rights are required.
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© D e Manoger 40 22000.126) T=T

Took

| cenee Actvaior | 5t | I I [ HECAD Karfgurston | HELES Kanfgursion |

i
=% 1m0z =] [ fo——

5 oot Mo v 30 [ :

[0 10021 ORD chsske Vaeson 20 (5| | LEseee HIZAD ciassc

77 MO Coepe vetsion 29807 L s o Sevvn z

o L z

51 1D0F|CAD e Ergineing Verisn® | | Moo L asior,

52 [ATIICAD W /4 Vevion 226 M e o sinukanecus e 10

Bl o Vericn 2291 | | Commbe okans o o

5 1008 Shee et Proevional Yison” | | Commses o e

B Vesan 238 | | Losese meiy doe i 3 235855 20

B Visson 22331

574 {073 Stos /Mol Ergramrg. Yerson”

B Voeson 2280

Bei asn®

Bei

B

sy

F]

Pl

A click on the Update licenses button opens a new dialogue window, in which the administrator enters the
character set received from the Client.

© 15D License Manager 40 22000.426) =)

e i To T T e

Jifi]

Ji focl [ a ]

PSD

After selecting OK, another dialogue opens, in which you enter the target path and the file name for the
licenses to be swapped out.

© IS0 License Manager 40 (22000126 T |
Tools
| 14D rorfiguratn | | Revoie Server wicense |
19216010232 Check Serves Hame / IF Seach neluak
ﬂ{;_?tlwﬂilwzlz | [ bome P——
TE] - [001] Pt Manager Vession 22330
@ e e et |8 | vesmiename HICAD chssic
A oD License name on Server 2
{1 [D04]HIGAD Sobsson Versin 22330 e w
LT [005] HICAD Steel Enginesing Vession ™ Masimum 'icersse chack OUIT ' dualion  Rieshicted Io kcerse spry.
(-0 [007] HICAD VI 28V Veersion "2233 1" Max number of swalansous sers 100
{1 1009] Desion Awnomation Veesion “2293.1 ‘Cammules tokens oocupied (]
{1 [003] Sheel Metal Fifessional Verson” | | Comertokens fee 100
L [070] BeamseProies Vession 2293 Licence sty dsle \vd dsn 31 235059 200
B 1] Weta Engreesing
8
a
g
| Q C\Lsenshwmwcoe\D e Femotel e Code =

Load use: corfigursion Commmuter hoense: Vil in days &

Updas bosness

Select OK to check out the commuter licenses from the License Server and swap them out to a file, e.g.
RemoteLicCode.lic.
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I5DLicenseManager

Commuter authorisation successfully created.

The successful checkout will be confirmed. The administrator then sends the file, RemoteLicCode.lic, to the
Client.

After receiving the file with the commuter licenses, the Client starts the ISD License Manager again and
activates the Install Remote Authorisation Code tab. Here the received commuter licenses can be installed
directly via file selection or via copying of the file contents.

15D Licene Manager 40 (2200.0126) =)

Taols
——
1
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Flaad suhosaaion code hom stemnal s
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CALlsersvemsen T ccuments\RemeteLicCode ke (™=

L:s

Click the Install... button to install the commuter licenses on the Client.

[ Info M

ié Installation successfully completed.

After successful installation, switch to the Standalone License Info tab. Press the Activate key. You are now
informed which licenses are installed locally on the computer.

105



Licensing

© 15D License Manager 40 (22000.126) el
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6.5 License Configuration

Some cases may require the use of only certain specific licences on a computer. Example: On the License
Server, HICAD creator and HiCAD solution licences are available. On one Client, HiCAD is to be started with
a HiCAD creator license; on another Client, HiICAD is to be started with a HICAD solution license. If the
selected license is no longer available, an application start is no longer possible.

O If there are several hasic modules in a standalone (workstation) license (to which also the Commuter
Licenses helong), it is mandatory to make a pre-configuration and save it as workstation configuration. If no
pre-configuration is possible, the HiCAD/HELiOS configuration tab will be displayed before the start of
HiCAD/HELiOS. If the selected configuration does not match the available licenses, a warning message will be
issued, with a list of available licenses. After this, the configuration selection will be displayed again.

6.5.1 License Configuration HiCAD

O 15D License Manager 40 (2201.0.254) | )
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On the HIiCAD Configuration tab of the ISD License Manager tool you have the option to save a workstation
or user configuration for individual Clients.

» Save as workstation configuration: This configuration will be saved for all users of this computer. When
HIiCAD is started, the selection window is no longer displayed (administrator rights are required for this).

» Save as user configuration: This configuration is only saved for the current user. When HiCAD is
started, the selection window with the saved configuration is always displayed.

These license configurations apply to network licenses and standalone (workstation) licenses.
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6.5.2 License Configuration HELIOS
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On the HELIOS Configuration tab of the ISD License Manager tool you have the option to save a workstation
or user configuration for individual Clients.

»  Save as workstation configuration: This configuration will be saved for all users of this computer. When
HELIOS is started, the selection window is no longer displayed (administrator rights are required for
this).

» Save as user configuration: This configuration is only saved for the current user. When HELIOS is
started, the selection window with the saved configuration is always displayed.

These licence configurations apply to network licenses and standalone (workstation) licenses.
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6.6  Important Softlock/Hardlock Information

When using the softlock/hardlocks as selector for the license file, please note that for system-inherent
reasons the date must not be reset! Such resetting causes a blocking of the softlock/hardlock that can only
be revoked by the ISD by means of a re-programming. In such cases, we would have to charge you the
costs of this unnecessary additional work.

A change of the system time is possible, as long as it is not date-comprehensive.

If you deem such date conversion absolutely necessary, please inform our staff on the hotline in good time.

ISD Software und Systeme GmbH
Phone: 0049 - 231/97 93 - 166
Fax: 0049 -231/9793-101
Mailto: helpdesk@isdgroup.de

Q

() IMPORTANT: If you have a 64Bit version of HiCAD/HELiOS, the hardlock can no longer be used as a license
file selector due to missing driver support!

O After performing an update (from Version 2008 or older) to HiCAD and HELiOS Version 2012 (or 2013) you
need to return your workstation dongle to the ISD! After this you can no longer use old HiCAD and HELi0S
Version.
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6.7 Theft of a Workstation

The user is responsible for appropriately insuring the HICAD/HELIOS workstations against theft. If desired,
we can tell you the reinstatement value of your software. If a workstation is stolen, you will need a new
license. In such cases, please send us the police report of the theft first. We will then provide you with a
license for a limited period of time, and submit an offer for a new license to you. The ISD will send you the
new license after clarification of the case with your insurance and receipt of your payment for the license
fee.
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/ HICAD at a Glance

HICAD is a universal CAD system with true 2-D/3-D associativity, innovative functions, comprehensive
industry solutions and an integrated PDM component. Up-to-date working techniques and numerous
automatisms help you abridge routine tasks. Simulation and analysis tools enable you to detect and prevent
possible collisions within your product models at early design stages.

» Performance characteristics:

Microsoft Windows standard and GUI based on the Windows “Ribbons” technology
Combined working in 2-D and 3-D
Assembly-oriented design engineering providing top performance even for very large assemblies

Transparency and clearness thanks to convenient search functions, filters and multiple selection
options

Extensive symbol and standard part catalogues

Simulation and analysis tools

Standardisation and automation

Direct modelling and parametric design

Integrated product data management with HELIOS

Data transfer from other systems (CATIA, ME10O, STEP, DXF, DWG etc.)
BOM-creation, PPS interface, transfer to NC programs

Comprehensive industry solutions for Steel/Metal Engineering, Plant Engineering, Sheet Metal
processing and Plant Engineering

Individually extendable due to a modular structure
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8 First Steps in HICAD
8.1  Start HiCAD

You start HiICAD by:
» using the Windows task bar (Start) to choose the Programs folder and then clicking the HiCAD icon

! inthe ISD ... menu, or

» by clicking the HICAD icon ?1 on your desktop.

Once you have started HICAD, the input window for License Management is initially displayed, followed by
the HICAD Start Centre (provided that it has not been deactivated).

If you use HICAD in conjunction with HELIOS, a login may be required to start HiICAD.

In order that you can take full advantage of the numerous new features and enhancements offered by
HELIOS 2016, a News window with videos explaining the new and changed HELIOS functionalities will be
shown upon HiCAD start. We will provide you with such videos with each Major Release and Service Pack to
keep you constantly informed in the best possible way.

You can configure the display of the News window at the bottom left. We recommend using the Show most
recent news option to ensure that you will never miss any news about HELIOS.

If you have selected Never show option, you can call the News window again at any time and change the
display option by clicking on the “?” symbol at the top right and selecting Show news.

© During the launch of HiCAD it is checked whether the required version of .NET Framework is actually
installed. If this is not the case, an appropriate error message is issued and HiCAD is closed.
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8.2 DLL Check

Due to entries in the Windows-Registry, more and more libraries from third parties (DLL file) are integrated
when HiCAD is launched, e.g. in order to capture messages or outputs to the screen. Some examples are

» Virus scanners,
»  PDF programs,

»  Programs for the recording of screen activities,
etc. These files can sometimes cause problems.

When you start HICAD, it will first be checked whether DLL files are assigned to the Registry value Applnit in
the Registry key

=  HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Windows (64Bit)

=  HKEY_LOCAL_MACHINEA\SOFTWARE\Wow6432Node\Microsoft\Windows
NT\CurrentVersion\Windows (32Bit)

If this is the case, the following message will be displayed:

mcao x|

Entries in the Windows Registry (AppInit_DLLs) cause an automatic
integration of third party libraries upon HICAD launch. Problems with
these third party libraries may also cause problems in HICAD. Contact
your administrator to switch off this mechanism.

- Suppress message

Activate the Suppress message checkbox if you do not want this message to be displayed upon future
HICAD starts. Also inform your administrator about the message. The message will not reappear until the
Registry value changes again, i.e. not until other DLLs will be loaded!

If you want to completely suppress the message, you can also set the registry value CheckBoxState in the
registry key

HKEY_CURRENT_USER\Software\ISD Software und Systeme\HiCAD [year version, e.g. 20171\Splash
Screen

to 1.

) Be careful when editing the Registry! The entering of incorrect values or the deleting of values can
destablilize the operating system!
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8.3  Close HiCAD

To close HICAD,
» click the Close icon &% or

» click the ISD button and select End.

If any HICAD drawings are still open at this point, you have the option to save them. You distinguish between
the current drawing that you see on the screen, and the other, still open drawings. If a drawing file with the
same name already exists, you can save the drawing under a different name, or overwrite the existing
drawing. Please note that no backup copy of the file will be created in such cases!

) When you close HiCAD, all files, with the exception of the automatic data backups, will be removed from
the TEMP sub-directory of your HiCAD installation.
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8.4  The Start Centre

When you start HICAD for the first time, the Start Centre is displayed, which has been designed to facilitate
your first steps of drawing creation.

HIiCAD Start Centre )

TS

{Create new drawing
@ Create new drawing (3-D/2-D part)

() Create new drawing (3-D assembly]

Scale: |1 g ¥ l
Start mode [ (nane) |

Create processing plane:

{Load existing drawing
() Load via database

[Na) v
(" Load via Explorer

) Load via 2-D Interface

() Load via 3-D Interface

[} %#Y-plane
[ %/Z-plane
[} #Z-plane
View projection:

View representation:

IStandatd axonometric

[7] Switch Start Centre display off

www.isdgroup.com

x|

Please note:

»  Click on the graphic to obtain information about the version number.

» When you call the Start Centre again, the values that you set last will be displayed as default values.

» The settings you have selected for the Create new drawing start action will even be used in HIiCAD if

you call the New drawing (without DB) function.

8.4.1 Create New Drawing

If you want to create a new drawing, specify whether you want to create a part drawing or an assembly

drawing by activating the appropriate checkbox.

»  Part drawing (detail drawing)

In a part drawing (detail drawing) you divide your drawing into main parts and sub-parts. To define the
part structure you use so-called dummy parts which symbolise the assembly. You then assign
assembly-relevant main parts and sub-parts to these dummy parts. Instead of dummy parts you may as

well use the special component type Assembly.

» Assembly drawing

You can define 3-D drawings directly when creating the assembly drawing and - if you are working in
parallel with HELIOS - enter them into the database. This provides significantly more efficiency,
particularly for referencing, itemisation and BOM-creation.
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8.4.2 Options

»

»

»

»

»

Enter drawing into database

If you are working with HELIOS you can define here whether you want to the new drawing to be entered
into the database. If you activate this checkbox, HICAD will prompt you to specify the document master
data once you exit the Start Centre. If not, you will be prompted to enter the name of the drawing file.

Activate, if desired, the project to which you want to assign the drawing.

Scale
Here you can preset the scale of the drawing.

Start mode

Here, choose the start mode you want to be activated once you exit the Start Centre, e.g. 2-D, if you
want to start the drawing in 2-D or 3-D Extruded solid, if you want to start your drawing by creating an
extruded solid in 3-D.

Create processing planes (3-D only)
Here you can specify which of the standard processing planes you want to create. Activate the
appropriate checkbox.

View projection and View representation (3-D only)
If you want to work in 3-D, use these functions to pre-set the model view and the view representation.

8.4.3 Load Existing Drawing

If you have chosen Load existing drawing as start mode, you can specify whether you want to load the
drawing via the database, the Explorer or via an interface. As with a new creation, you may also activate the
project directly.

8.4.4 Switch Start Centre Display Off

If you activate the Switch Start Centre display off checkbox and click OK to exit the Start centre, the current
settings will apply as the default settings for whenever you start HICAD again and create new drawings. The
Start Centre is then no longer displayed. To re-activate the Start Centre display and to change the settings,
choose the Activate Start Centre function. The changed settings will be applied when starting HICAD again.

If you click OK to exit the Start Centre, the current settings are used as the default setting if, on the other
hand, you exit the Start Centre by pressing the ESC key or the £ icon, the settings are ignored.
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9 HELIOS at a Glance

On the way to the finished product, time expenditure, the cost situation and product quality can only be
optimised if all departments of a company work together efficiently. This requires a well-structured and
efficient exchange of information between the parties involved in the production process - from
Manufacturing, Purchasing and Service to Marketing and Sales.

HELIOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-free gathering,
distribution and management of the data that is required for the process chain. Once saved, these data can
be re-used within the entire company and for the complete product life cycle. HELIOS manages and controls
all process cycles by regulating and monitoring the processing and transfer of these data.

Thus, the know-how of the company will be used optimally, redundant work can be avoided and error
sources will be eliminated.

HELIOS combines Product, Process and Peripherals Management to form a single system, thus making
HELIOS the knowledge reservoir of your company.

HELIOS can be integrated in your overall CAD system or used as a stand-alone system, the so-called
HELIOS Desktop.

Thanks to its modular structure, HELIOS can be optimally adapted to company-specific requirements.
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10 First Steps in HELIOS

»  Program Call
Start the HELIOS Desktop by double-clicking the HELIOS.EXE file in the \HICAD\exe directory or via the

. o
program icon on your Desktop.

Default setting is the project-independent start. Please note that the list view in the right-hand window will
not be shown when you start HELIOS Desktop for the first time. Select a project first and display the list view
via View and then Lists.

If you have not ended HELIOS correctly during your last session, you will receive an error message from the
Vault Server.

» News window

In order that you can take full advantage of the numerous new features and enhancements offered by
HELIOS 2016, a News window with videos explaining the new and changed HELIOS functionalities will be
shown upon HiCAD start. We will provide you with such videos with each Major Release and Service Pack to
keep you constantly informed in the best possible way.

You can configure the display of the News window at the bottom left. We recommend using the Show most
recent news option to ensure that you will never miss any news about HELIOS.

» Registration

The HELIOS User Management is based on the User Management of Windows. If several users are
registered with the same Windows User Name in EDBSETUP, a login mask will appear when starting
HELIOS Desktop.

Name and active group enable the user to login with the rights guaranteed by the User Management.

If you select a project from the Active Project drop-down list, this project will be opened after starting
HELIOS Desktop. If you select the project-independent setting, all documents will be displayed.

Start the HELIOS Desktop with Login (see below).

To ensure that a specific project will be opened after starting HELIOS Desktop, you need to specify a Start
Project. On the Ribbon, activate the Tools tab, then select Options, activate in the dialogue the General tab
and choose a start project.

» Login

Use the Login 13 function for a new login while working with the HELIOS Desktop, e.g. to work with different
rights without having to exit the program.

= Activate the Login "3 function on the QuickAccess toolbar.
= Select a different user.

» |f required, change the active project and confirm the new settings with Login.
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11 How to Use the Help

The Online Help provides you with information, descriptions and examples on all functions and techniques
which are available in HICAD — from 2-D and 3-D to the integrated PDM functionality, Sheet Metal
Processing to Steel/Metal and Plant Engineering.

(0 Please note that the scope of available functions may vary, depending on the configuration level of your
HiCAD product. This means that some of the functions described in the Online Help may not be available.

The Help is available both locally (status of the installation DVD) and on the Internet (regularly updated) at
help.isdgroup.com. Both versions of the Help can be called from HIiCAD via the Help Topics and Information
item (“?” icon on the top right of window). You can select your preferred Online Help type via ? > Help

Settings.

boll HELIOS POM + -k |
£ Help |
| 738t 92 | Hetwtopics
Tal Scale | List help topics
Propertiss QuickTaur
Drawing
HiCaD

Licenges

You call the HELIOS Help via the HELIOS Desktop Help menu item.

=181
~ ) View ~ 0'

HELIOS Desktop Help
Own Help ...
About HELIOS Desktop ...

To be able to use the Internet version of the Help, you need to register for the ISD’s new company Wiki
once. This will not only give you access to the new Help, but also provide you with many other information
which will be made available shortly in the ISD Wiki (Forum, Download area etc.).

Click Sign up in the login window of the Online Help to register. If you have already been registered, enter
your access data and click Login to get directly to the start page of the Online Help.
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‘ Avoutus | News | \_+4940)23197930  DE | EN

THE WORLD OF CAD AND PDM SOLUTIONS

Login FAQ Further Information Back to ISD Website

ISD Online Help
Login

Username *
Password

Not yet a member? Sign up.

Register for the ISD Wiki

After clicking Sign up in the Login window of the Online Help, enter the data required for the ISD Wiki in the
dialogue window. Confirm the security prompt and click the Sign up button.

ISD - Wiki e
“THE WORLD OF CAD AND FOM SOLUTIONS
Product know-how Forum Brochures Download ?
Sign up

Full Name

Email
Username
Password

Confirm Password

CEGEER

Already have a usemame and password? Log in here

After the registration the dashboard of the ISD Wiki will be displayed. A message indicates whether you have
been authenticated as an ISD customer.

If you could be identified as an ISD customer, you can now directly launch the Online Help using your
registration data.

If you could not be identified as an ISD customer, please perform the steps described in the message.
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12 What’s New in Version 20177

A detailed overview of all new features and enhancements contained in HICAD 2017 can be found in the
What's New? topic of the Online Help.

You can also click on the Mo button in the Help.

An overview of new features in PDF format will open if you click the m button in the Download area
of the Wiki.
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